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About this User Guide

This document serves as a user's guide for the 64-bit versions of TerraMatch. TerraMatch UAV is
aiming to users who process point clouds collected with UAS (Unmanned Airborne Systems,
also referred to systems carried by Drones). Tools available in TerraMatch and TerraMatch UAV
work identically in all versions. Tools that are not available in TerraMatch UAV are marked with
"Not UAV" in the documentation.

This user guide is written under the assumption that the reader knows how to use the basic
features of the used CAD platform. You should refer to any documentation of your respective
CAD platform whenever you need information about tools and functionality of the CAD
platform itself.

The PDF version of the user guide is created in order to provide an offline version of the online
webhelp. It shall be updated together with the webhelp. Some parts of the webhelp may be
left out on purpose in the PDF document. In case of inconsistency, the online webhelp is the
primary source of information. The user is responsible for keeping his/her offline version
updated.

Document conventions

The following conventions and symbols appear in this guide:

· Data click - click on the data button, usually the left mouse button on a right-hand mouse.

· Reset click - click on the reset button, usually the right mouse button on a right-hand mouse.

· < > - angle brackets are used to refer to keyboard keys, for example, <Enter>.

· Command - type a command in the Spaccels window of Spatix or the key-in line of Bentley
CAD and then press <Enter>.

· OR - alternate procedures or steps in a procedure.

· C:/TERRA - paths to directories of files on a hard disk are written with capital letters.

· To do  - the beginning of a workflow is introduced with bold-italic letters.

· When no distinction between platform versions (Spatix or Bentley) is necessary, this
document refers to the CAD environment simply as "CAD platform".

Notes and hints are highlighted in light blue boxes.

Spatix documentation

The User Guide for Spatix is published by GISware Integro and delivered as PDF with the
software. It can be opened with the Manual command from the Help menu of Spatix.

Terrasolid software runs on top of Spatix. The functionality of Terrasolid software is the same as
on top of Bentley products whenever possible. Any differences are clearly mentioned in the
User Guide.
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Bentley CAD documentation

Terrasolid software runs on top of the full version of Bentley CAD products, such as
MicroStation, PowerDraft, or OpenCities Map PowerView. Compatible Bentley products are
listed on Terrasolid's webpage. The CAD platform causes no difference in functionality of
Terrasolid software. Therefore, only the term "Bentley CAD" is used when referring to any
Bentley product.

https://terrasolid.com/software-downloads/
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Introduction

TerraMatch is a sophisticated tool for improving the accuracy and quality of the raw laser point
cloud. It compares laser data from overlapping flight or drive paths and calculates correction
values for the misalignment angles as well as xyz location errors. The comparison and
correction value calculation can be either based on surface matching or on different types of tie
lines. Tie line matching comprises points or lines on horizontal, vertical or sloped surfaces that
can be used for matching flight/drive paths to each other, but also known point or line locations
that enable the adjustment of the laser point cloud to control measurements.

Especially in mobile ground-based laser scanning, the mismatch between overlapping drive
paths usally changes over time during a surveying campaign, depending on the quality of the
GPS signal on different locations. This requires a fluctuating correction solution which can be
achieved with control measurements and TerraMatch tie lines.

TerraMatch is also used for misalignment angle calibration which should be checked and
possibly improved at the beginning of data processing. For this purpose, data is collected on a
specific calibration side which offers a point cloud dedicated for the calibration task to the
software. If the system includes several laser scanners, the calibration involves scanner-to-
scanner matching.

TerraMatch must be accompanied by TerraScan or TerraScan Lite.

General data requirements

The input data must meet some requirements to enable the algorithms to work properly:

· The data set must contain multiple strips which overlap each other. Alternatively, a single
strip can be compared against a dense set of known points.

· The data set must contain some well-defined surfaces or other identifiable features for
placing tie lines -- matching can not be performed if all the data are hits in forest canopy
where no meaningful surfaces or features can be detected.

· Time-stamped trajectory information must be imported into TerraScan.

· For systematic shift corrections (positional or angular), a trajectory must not overlap itself.
Any trajectories which make a 180 degree turn and return over itself, have to be split into
separate parts using TerraScan.

· Laser points must be linked to trajectory positions so that TerraMatch can derive the laser
scanner position and orientation for each laser point. This requires that laser points and
trajectories use the same time stamp format.

The specific data requirements for different processing workflows are described in Methods of
line adjustment.

TerraMatch UAV

TerraMatch UAV is a lighter version of TerraMatch. It is dedicated to users that process only
point clouds collected by Unmanned Airborne Vehicles (UAVs, also called Drones). UAV
systems produce relatively small point clouds from a low altitude. The system is more unstable
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in the air. Often, less capable/expensive hardware is used which leads to a higher inaccuracy
level of the raw data. Therefore, the improvement of the data accuracy by eliminating
boresight misalignment and positional inaccuracies caused by a bad trajectory solution plays an
important role in the processing workflow. The UAV version of TerraMatch is well suited for
processing point clouds up to a few million of points.

TerraMatch UAV does not have any project capabilites. Tools can be performed on points
loaded in memory but not on project level.

Tools/Commands without project option

· Apply correction

· Tie lines/Import points

· Tie lines/Search tie lines

· Tie lines/Search cloud-to-cloud

· Find match

· Find fluctuations

· Match forward and backward

· Measure match

TerraMatch UAV is available only in a bundle with other Terrasolid UAV software versions, such
as TerraScan UAV, TerraPhoto UAV and/or TerraModeler UAV. TerraMatch UAV must be
accompanied by either TerraScan UAV or TerraScan.

The Function matrix provides a complete overview of the tools in the different TerraMatch
versions.

Hardware and software requirements

TerraMatch is built on top of a CAD platform, such as Spatix or Bentley CAD. You must have a
computer system capable of running any compatible CAD platform.

To run TerraMatch, you must have the following:

· quad-core or better processor, good frequency rate

· 64-bit version of Windows 7, 8, 10

· 1024*768 resolution display or better

· 8 GB RAM minimum, 16 GB RAM or more recommended

· Any of the compatible CAD platforms:
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GISware Integro, purchased by
Terrasolid

Bentley

· Spatix · MicroStation CONNECT Edition

· PowerDraft CONNECT Edition

· OpenCities Map PowerView
CONNECT Edition

· OpenCities Map CONNECT Edition

· OpenCities Map Enterprise
CONNECT Edition

· ContextCapture Editor CONNECT
Edition

· OpenRoads Designer

Installation of TerraMatch requires about 1 MB of free hard disk space.

Installation

Terrasolid applications may be delivered as a zip file or on a USB-Stick. The installation package
of Terrasolid applications for Spatix includes the setup for Spatix itself as well. Therefore, you
can install Spatix and Terrasolid software in one step.

A zip package contains the software - it does not include the User Guides. This is the normal
delivery method of the software if you download it from the Terrasolid website.

A USB-Stick may include the User Guides in PDF format in addition to the installation files. The
USB-Stick may further include versions for multiple environments. You choose the version
which corresponds to your operating system and platform version. You install Terrasolid
software from an USB-Stick probably only if you participate in a training event.

Terrasolid applications for Bentley products and Spatix may be installed on the same computer
and run parallel. The applications should be installed in the same directory (e.g. c:\terra64).
This enables the use of the same configuration files, settings, etc. for both platforms.

To install TerraMatch from a zip file together with or on top of Spatix:

1. Unpack the zip archive with any zip file manager.

2. Start SETUP.EXE which is part of the zip archive. You must have administrator permissions in
order to run setup successfully.

The installation program tries to determine where Spatix has been installed and opens the
Terra Setup dialog:

https://terrasolid.com/software-downloads/
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3. Check and possibly change the installation folder of Spatix. Click on the Browse button next
to the input field in order to select a new installation folder for Spatix. The folder is created
automatically, if it does not exist.

4. Define the installation folder(s) where to install TerraMatch and maybe other Terra
applications.

The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.

As an alternative, if executables and settings files need to be separated, select another
Folder choice:

· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,
setting files are installed into C:\TERRA64.

· Freely selectable folders - the user defines a folder for Executables and Settings in the
corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.

5. Select all Terrasolid applications that you want to install.

Select either the full version, the UAV version or the Lite version of an application. The
versions do not run parallel on the same CAD platform.

6. Click OK to start the installation.

A message is displayed when the installation is finished.

Install all Terrasolid applications into the same folder(s) in order to ensure interaction
between the applications without trouble.
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To install TerraMatch from a zip file on top of any Bentley  product:

1. Unpack the zip archive with any zip file manager.

2. Start SETUP.EXE which is part of the zip archive.

This may open a dialog confirming the execution of SETUP.EXE and/or prompting for the
administrator password.

The installation program needs to know where the Bentley product (MicroStation, Map
PowerView or any other compatible product) has been installed. It automatically searches all
local hard disks to find the Bentley installation directory.

The installation dialog opens:

The dialog is the same for all Bentley products and Terra applications. The labels in the dialog
always refer to "MicroStation", no matter what Bentley product is used.

3. Check the MicroStation directory. Replace the path if the correct location was not found
automatically.

4. Define the installation folder(s) where to install TerraMatch and maybe other Terra
applications.

The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.

As an alternative, if executables and settings files need to be separated, select another
Folder choice:

· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,
setting files are installed into C:\TERRA64.

· Freely selectable folders - the user defines a folder for Executables and Settings in the
corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.
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5. Click OK to start the installation.

A message is displayed when the installation is finished.

Install all Terrasolid applications into the same folder(s) in order to ensure interaction
between the applications without trouble.

The installation folder contains a README.TXT file which explains the installation of the
software in batch mode. The allows to install several Terrasolid applications in one step.

To install TerraMatch from USB-Stick on top of a Bentley  product:

The process is the same for all Bentley products. The labels in all dialogs always refer to
"MicroStation", no matter what Bentley product is used.

1. Insert the USB-Stick.

2. Locate the correct installation directory on the stick.

3. Start SETUP.EXE from that directory.

The installation program tries to determine where MicroStation has been installed and
opens the Terra Setup dialog.

4. Define the directory where to install TerraMatch and maybe other Terra applications.

The default path is C:\TERRA64. You can change this to another location. The specified
directory is created automatically, if it does not exist.

5. Check the MicroStation directory. Replace the path if the correct location was not found
automatically.

You can use the Scan button to automatically search the hard disk for the Bentley CAD
installation. Alternatively, you can use the Browse button to locate the Bentley CAD platform
installation folder yourself.

6. Click OK to continue.

This opens another Terra Setup dialog.

7. Select the TerraMatch for MicroStation item in the dialog.

You may select all applications for which you have installation files.

8. Click OK to start the installation.

A message is displayed when the installation is finished.

Starting TerraMatch

TerraMatch is an application that runs on top of Spatix (Ix App) or Bentley CAD (MDL
Application).
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To start TerraMatch in Spatix:

1. Select Execute command from the Ix Apps menu in Spatix.

The Choose Ix app to execute dialog opens, a standard Windows dialog to open a file.

2. Browse to the /APP folder of the Terrasolid software installation directory.

By default, the path is C:/TERRA64/APP.

3. Select the tmatch.ix file.

You may select other applications as well.

4. Click Open in order to start all selected applications.

TerraMatch opens the Main tool box.

To start TerraMatch on Bentley  CAD:

1. Select MDL Applications command from the Utilities ribbon in Bentley CAD.

The MDL dialog opens:

2. In the Available Applications list, select TMATCH.

3. Click on the Load button.

OR

1. Key in mdl load tmatch.

TerraMatch opens the Main tool box.
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If the TerraMatch Main toolbox is accidentally closed, it can be re-opened with the keyin
command:

match app maintool

The Available Applications list shows all MDL applications that Bentley CAD  is able to locate.
Bentley CAD searches for MDL applications in the directories listed in MS_MDLAPPS
configuration variable. If Bentley CAD can not find TMATCH.MA, you should check the
variable in the Configuration Variable dialog of Bentley CAD. Make sure the directory path of
the TMATCH.MA file is included in the variable values. See also Installation Directories and
Configuration Variables for more information.

Unload TerraMatch

TerraMatch is unloaded automatically when you exit Spatix or Bentley CAD. Sometimes you
may want to unload the application while continuing to work with the CAD platform. This frees
up the memory reserved by TerraMatch.

To unload TerraMatch in Spatix:

1. Select tmatch.ix command from the Ix Apps menu in Spatix.

The IxApp Properties dialog opens:

2. Click on the Stop button.

This unloads TerraMatch, closes the Main tool box and updates the Status and IxApp Info in
the IxApp Properties dialog.

3. Close the dialog with OK or Cancel.

To unload TerraMatch in Bentley  CAD:

1. Select MDL Applications command from the Utilities ribbon in Bentley CAD.

The MDL dialog opens:
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2. In the Loaded Applications list, select TMATCH.

3. Click on the Unload button.

OR

1. Key in mdl unload tmatch.

This unloads the application.
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TerraMatch Settings

Settings control the way how tools and commands of TerraMatch work. They are organized in
logical categories. The TerraMatch Settings dialog is opened by the Match Settings tool.

SETTINGS CATEGORY

Default trajectory accuracy

Iteration convergence

Operation

Signal markers

Standard deviations

Target objects

Tie line detail views

Tie lines

Default trajectory accuracy

Default trajectory accuracy category defines estimates for the accuracy of trajectory positions.
They are used for smoothing the correction curve in Find Tie Line Fluctuations if no other
accuracy estimate values for trajectory positions are available.

The default values are recommended estimates for mobile data collected along rural roads.
Larger values might provide better estimates for data collected inside urban areas.

Iteration convergence

Iteration convergence category determines the stage at which the iterations in finding match
tools stop. The iteration stops if the improvements are smaller than these threshold values or
the match no longer improves.

You may use bigger values if you want to stop the iteration sooner and just find an indication
for the type of error in the data set. You should use small values when you want to find the
exact correction parameters.

SETTING EFFECT

Easting Easting convergence (m) - typically between
0.001 and 0.10.

Northing Northing convergence (m) - typically
between 0.001 and 0.10.
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SETTING EFFECT

Elevation Elevation convergence (m) - typically
between 0.001 and 0.10.

Heading Heading convergence (deg) - typically
between 0.0001 and 0.10.

Roll Roll convergence (deg) - typically between
0.0001 and 0.010.

Pitch Pitch convergence (deg) - typically between
0.0001 and 0.010.

Operation

Operation category defines the maximum number of threads that are used by TerraMatch
processes. This effects some of the processes in TerraMatch which can run on several threads.

In addition, you can select whether the Main tool box of TerraMatch is opened at startup or not.

Signal markers

Signal markers category lets you define signal markers which can be used for automatic tie line
placement. Signal markers are bright paintings on dark ground surfaces, e.g. on a road surface,
at the location of a control measurement. The signal marker can be identified in the intensity
values of a dense laser point cloud. This enables the automatic placement of known xyz or
known xy tie points.

The signal marker has to be drawn into a CAD file before it can be defined in TerraMatch. It may
be advantageous to use an empty CAD file for the drawing and to place the signal marker in a
way that the point of measurement corresponds to the CAD file origin. The drawing must
include a larger rectangle that represents the dark background and the shape of the bright
painting. An example is illustrated in the figures below.

Signal marker painting on a tram track
Signal marker drawing in CAD
file

Signal marker definition in
TerraMatch
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To define a signal marker:

1. Create a drawing of the signal marker in a CAD file.

2. Select the drawing.

3. Open Signal markers category from TerraMatch Settings.

4. Click Add in the Settings dialog.

5. Define the exact measurement coordinate of the signal marker by either snapping to the
drawing origin (= point of measurement on the signal marker location) or by typing the
command:

xy=0:0 (Spatix)   OR   xyz = 0,0,0 (Bentley CAD)

where 0,0,0 is the origin coordinate of the drawing.

This opens the Signal marker dialog:

6. Define settings and click OK.

This adds the new signal marker to the list.
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SETTING EFFECT

Name Name of the signal marker.

Placement Location of the signal marker:

· Ground surface - signal painted on a
horizontal surface, such as the ground.

· Vertical surface - signal painted on a vertical
surface, such as a tunnel wall or pole.

Flipping Defines the signal marker pattern relative to
the movement direction:

· Not used - no flipping used.

· Horizontally - signal can be flipped
horizontally.

· Vertically - signal can be flipped vertically.

A signal marker’s settings can be modified by selecting the marker and clicking the Edit
button in the Settings dialog. It can be deleted using the Delete button.

Standard deviations category

Standard deviations category specifies the assumed accuracy of orientation parameters. These
settings help the algorithm to avoid singularity and to better translate observed mismatches
into corrections.

SETTING EFFECT

Easting Easting (m) - typically between 0.020 and
0.250.

Northing Northing (m) - typically between 0.020 and
0.250.

Elevation Elevation (m) - typically between 0.020 and
0.250.

Heading Heading (deg) - typically between 0.010 and
0.200.

Roll Roll (deg) - typically between 0.010 and
0.200.

Pitch Pitch (deg) - typically between 0.010 and
0.200.

Known points Known points (m) - typically between 0.005
and 0.05.
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Target objects category

Target objects category lets you define target objects for adjusting the position of mobile laser
scanning data. Target objects are objects with a known three dimensional shape placed at a
control point location. From target objects, you can import Known XYZ, Known XY, or Known Z
tie points.

To define a target object:

1. Open Target objects category from TerraMatch Settings.

2. Click Add in the Settings dialog.

This opens the Target object dialog:

3. Enter settings and click OK.

SETTING EFFECT

Name Name of the target object.

Type Type or shape of the target object. Currently,
the only support type is Ball.

Radius Radius of a target object of type Ball.

Tie line detail views category

Tie line detail views category defines how the point cloud is displayed in CAD file views for the
different tie line types. The settings effect only the detail views for tie line display. For each tie
line type, a point attribute can be selected from a list in the settings dialog. A detailed
description of the display options for point clouds is provided in the TerraScan User Guide. The
default settings are shown below.

https://terrasolid.com/guides/tscan/mwdisplaymode.html
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Tie lines category

Tie lines category specifies what tie lines of type Section line following surface slopes are used
for solving XY and Z mismatch. The settings mainly effect fluctuating XYZ solutions. Anyway, the
values should be set in a reasonable way for a data set. The default values (XY when slope > 45
deg, Z when slope < 45 deg) are for mobile data sets where vertical walls are available for XY
matching. It is recommended to change them to smaller values for airborne point cloud data,
such as XY between 15 and 30 degree and Z accordingly. The steeper slopes there are in the data
set (in the terrain and/or building roofs, potential places for searching Section tie lines), the
larger the value for XY can be. A larger value for XY leads to a more reliable fluctuating XY
solution for a data set.

SETTING EFFECT

Xy when slope > Section lines are used to solve XY mismatch if
the slope gradient is larger than the given
degree value.

Z when slope < Section lines are used to solve Z mismatch if
the slope gradient is smaller than the given
degree value.



TerraMatch User Guide  © 2024 Terrasolid Ltd

23Tool Reference > Methods of line adjustment >  

Find match vs. Tie Lines

There are two methods of strip adjustment in TerraMatch, Find Match and Tie Lines. The
methods are compared in the following table.

FIND MATCH TIE LINES

Tool Find Match
Tool Find Fluctuations

Tool Find Tie Line Match
Tool Find Tie Line Fluctuations

Surface-to-surface matching Feature-to-feature matching

Only one type of observation Several types of observations

More time consuming adjustment Less time consuming adjustment

New (better) observations for each iteration Old observations included for each iteration

No manual observations Manual observations possible

INPUT DATA

· trajectories with time stamp

· laser points linked to trajectories and
classified into ground (and optional
buildings) per strip

· (optional) ground control points

· trajectories with time stamp

· tie lines derived from laser points, linked
to trajectories by time stamp

· (optional) ground control points

SOLVABLE PARAMETERS

· easting, northing, elevations shifts

· heading, roll, pitch shifts

· mirror scale

· easting, northing, elevations drifts

· heading, roll, pitch drifts

· fluctuating elevation

· easting, northing, elevations shifts

· heading, roll, pitch shifts

· mirror scale

· fluctuating easting/northing, elevation,
heading, roll, pitch

OBSERVATIONS

· triangulated model from each strip surface

· compares overlapping laser points and
ground control points against this surface

· translates observed difference and
gradient to heading, roll, pitch, elevation
difference

· surface/section lines - follow direction of a
surface

· ground lines/points - located on paint
markings

· roof intersection lines - located at an
intersection of two roof surfaces

· known lines/points - located at known
point locations
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ALS Calibration

TerraMatch can be used to solve the mirror scale parameter and the misalignment between the
laser scanner and the inertial measurement unit (IMU). The misalignment is expressed as
heading, roll and pitch angular correction values which need to be known for every laser
scanner system.

Different laser scanners may require additional calibration parameters as well. Those must be
solved using more manual methods with TerraScan or with system specific software.

Flight pattern

The optimal site for a calibration flight contains both flat and sloped surfaces which do not have
disturbing surface objects such as low vegetation. The most commonly used target area for
calibration is an airport as it is easily accessible and most often contains suitable surfaces, such
as the run ways and sloped building roofs.

The minimum flight pattern for calibration is four flight passes over the same area in a cross like
pattern where the slopes surfaces are located at the center of the cross, as shown in the figure
below.

You may consider some additional flight passes which may improve the quality of the
calibration:

· An additional flight pass for which the sloped surfaces are located at the right of left edge of
the corridor covered. This helps to differentiate pitch and heading from each other.

· Additional flight passes at a higher or a lower altitude.

Processing steps

The processing of a calibration flight can be outlined with the following steps:
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1. Solve GPS trajectories.

2. Compute xyz laser points with system specific software using the last known calibration
values.

3. Import trajectories into TerraScan and transform them to any coordinate system.

4. Split any trajectories which overlap themselves.

5. Import time-stamped laser points into TerraScan and transform them to the same coordinate
system.

6. Make sure that the flightline numbering of the laser points matches trajectory numbers (in
TerraScan, use Deduce using time command from Line pulldown menu).

Continue according to the matching method.

Surface-to-surface matching:

7. Classify low points.

8. Classify ground separately for each flightline.

9. (Optional) Classify some buildings separately for each flightline.

10. Smoothen ground surface if most of it is asphalt or some other hard surface.

11. Run Find Match and solve for heading, roll, pitch and mirror scale corrections for the whole
data set.

12. Add the result values to the correction values used when computing the xyz points in step 2.

Tie line-based matching:

7. Search for tie lines of type Surface lines. This does not require any classification of the laser
points.

8. Run Find Tie Line Match and solve for heading, roll, pitch and mirror scale corrections for the
whole data set.

9. Add the result values to the correction values used when computing the xyz points in step 2.

The laser scanner may have operation modes which make calibration easier such as profile
mode. If such a mode is available, it should be used to solve the pitch correction value first.
Then TerraMatch should be used to solve for heading and roll correction only.

ALS Project workflow

Even though the system has been calibrated, you may still find systematic errors in project data.
TerraMatch can be used with actual project data to solve mismatches between laser data from
different flightlines or between laser data and known points.

https://terrasolid.com/guides/tscan/mwdeduceusingtime.html
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All parallel flightlines covering a project area should have a crossing flightline at both ends. For
large project areas it is recommended to fly at least two or more crossing flightlines over sloped
open terrain in order to provide good data for the matching task. Known points (ground control
points) should be distributed close to the corners or edges of the project area.

As the project data volume can be huge, it is desirable to minimize the number of steps in the
processing workflow. You probably want to run TerraMatch only if you notice that there are
significant mismatches in the laser data.

Another difficulty with project data is that you do not know the nature of the errors
beforehand. Mismatches may be a result of mistakes made during the setup of GPS reference
stations, during computing trajectories or during operation of the airborne system. At some
point within the correction workflow you must establish what parameters need to be
corrected.

Processing steps

The general project workflow can be outlined with the following steps:

1. Solve GPS trajectories.

2. Compute xyz laser points with system specific software using the last known calibration
values.

3. Import trajectories into TerraScan.

Split trajectories if necessary.

4. Import time stamped laser points into TerraScan.

Make sure that the flightline numbering of the laser points matches trajectory numbers (in
TerraScan, set Line to Deduce using time in the Import points into project dialog for laser
points or use Deduce using time command from Line pulldown menu or the corresponding
Macro step).

5. Compare flightlines visually in cross sections. Try to locate sloped surfaces both along flight
direction and perpendicular to flight direction.

6. If no significant mismatches are visible, you may skip the consecutive steps and continue
with the normal processing workflow.

7. Classify low points.

8. Classify ground for each fligthline. If necessary, exclude water areas from the ground class.

9. (Optional) Locate areas which are best suited for matching (crossing flightlines, visible clean
sloped surfaces). Create a TerraScan project with blocks only in those areas.

10. (Optional) Classify buildings for each flightline at the locations which are best suited for
matching.

Continue according to the matching method.

https://terrasolid.com/guides/tscan/prjimportpointsintoproject.html
https://terrasolid.com/guides/tscan/mwdeduceusingtime.html
https://terrasolid.com/guides/tscan/madeducelinenumbers.html
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Surface-to-surface matching:

11. Run Find Match and solve for heading, roll, pitch and mirror scale corrections for the whole
data set.

Apply the correction if it is significant.

12. Run Find Match and solve for elevation or roll + elevation correction for individual
flightlines.

Apply the correction if it is significant.

13. Run Find Fluctuations and solve for fluctuating elevation correction.

Apply the correction if it is significant.

Tie line-based matching:

11. Search for tie lines of type Surface lines based on ground and (optional) building class.

12. Run Find Tie Line Match and solve for heading, roll, pitch and mirror scale corrections for the
whole data set.

Apply the correction to the tie lines and the laser data if it is significant.

13. Check the tie lines for worse observations.

14. Run Find Tie Line Match and solve for heading, roll, pitch and elevation corrections for
flightline groups (if there are any). Depending on the system, solve for mirror scale
corrections per flightline groups as well.

Apply the correction to the tie lines and the laser data if it is significant.

15. Check the tie lines for worse observations.

16. Run Find Tie Line Match and solve for heading, roll, pitch and elevation corrections for
individual flightlines.

Apply the correction to the tie lines and the laser data if it is significant.

17. Check the tie lines for worse observations.

18. Run Find Tie Line Fluctuations and solve for fluctuating elevation corrections.

Apply the correction to the laser data if it is significant.

After each Apply corrections step you should check the flightlines visually in cross sections or
using distance coloring to determine if the correction step improved the data. You have to
decide if the correction was good or if you need to go back one step and try solving
parameters with different settings.
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Multi-day projects

Use GPS standard time to avoid conflicts between flight sessions with identical GPS seconds-of-
week time stamps. There are tools in TerraScan for converting between GPS seconds-of-week
and GPS standard time and vice versa. The tools are applicable to trajectories and to laser data.

Apply a group number to trajectories for each flight session (day 1 = trajectory group 1, day 2 =
trajectory group 2, etc.). Optionally apply also a quality tag to trajectories of a flight session, e.g.
if flight conditions are worse on one of the days.

Reduce the amount of data for processing as much as possible. This includes thinning of
trajectories during the import, but also reducing the number of blocks for matching in a
TerraScan project. Use only blocks that are suitable for the matching task and only classes that
are necessary (e.g. ground, building classes).

For adding a new data set to an already matched data set, apply quality “bad” to the trajectories
of the new data set and quality “normal” or “good” to the trajectories of the old data set. Use
Find Match or Find Tie Line Match and solve for corrections for the “bad” flightlines only.

MLS Calibration

The task of mobile scanner calibration includes solving misalignment angles heading, roll and
pitch for each scanner in a system. Misalignment issues are visible in the point cloud as
differences between points of different drive paths and points of different scanners. The
misalignment is more and more noticeable in the data the longer the distance is from the
scanner. It has practically no effect on close-by objects, for which rather trajectory xyz
inaccuracies dominate.

Potential objects for mobile scanner calibration are vertical planar surfaces, such as building
walls, building corners and horizontal hard planar surfaces. A heading misalignment effects the
xy location of a vertical surface or a building corner while roll and pitch effect the verticality of
vertical surfaces as well as the elevation of horizontal surfaces in left/right (roll),
forward/backward (pitch) direction. Other usable objects are vertical poles and overhead wires,
but those objects have disadvantages, such as being off from vertical or varying diameters
(poles) and possible movement (wires).

The tie line types used for calibration are Section lines on planar horizontal or vertical surfaces
and Xy points , for example on building corners. More information about different tie line types
can be found in section Tie line types.

Drive pattern

A good calibration side is an open space with hard surface ground and without disturbing
objects such as cars, trees, etc. At least on one side there should be a larger building wall or
another large vertical surface without many detailed structures.
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The calibration drive may includes two drive paths in opposite direction parallel to the vertical
surface, two drive paths in opposite direction perpendicular to the vertical surface and
(optionally) two diagonal drive paths towards or away from the vertical surface. Another option
is to drive over an intersection of two road with at least two buildings next to the crossing, both
roads in opposite directions. The two calibration drive pattern are illustrated below.

Only a suitable drive pattern for the appropriate scanner configuration ensures that all
calibration parameters can be solved based on the laser data. The drive pattern described here
are optimized for calibrating scanner systems that contain two scanners which are rotated
horizontally by about 45 degree off from the driving direction. For any significantly different
scanner configuration, the drive pattern must be adjusted accordingly.

Scan direction for solving
Heading

· mismatch visible at a longer
distance from scanner

· mismatch visible on vertical
walls if scanned from
different angles (preferable
close to 45 degree)

· mismatch visible on point-like
objects (building corners,
poles, etc.)

Scan direction for solving Roll

· mismatch visible at a longer
distance from scanner

· mismatch visible on vertical
walls that are leaning in the
point cloud if scanned in
left/right direction relative
to the drive direction

· mismatch visible as
elevation difference on the
ground

Scan direction for solving Pitch

· mismatch visible at a longer
distance from scanner

· mismatch visible on vertical
walls that are leaning in the
point cloud if scanned in
forward/backward direction
relative to the drive direction

· mismatch visible as
elevation difference on the
ground

Drive pattern option 1, e.g. on a parking lot Drive pattern option 2, road crossing

 Processing steps

The processing of a calibration data set can be outlined with the following steps:
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1. Generate trajectories with the GPS-IMU post-processing software of your system.

2. Generate a point cloud with system specific software using the last known calibration values.

3. Define a scanner system in TerraScan Settings that stores the lever arms from IMU to each
scanner of your system.

4. Import trajectories into TerraScan. Assign the correct scanner system.

5. (Optional) Import the accuracy estimate file for the trajectory.

6. Import the laser cloud into TerraScan. In ideal case, you can load all points from the
calibration drive into memory and thus, work on loaded points. Assign the scanner number
during the import, e.g. based on the file or folder name. The scanner number for laser points
must be the same as the scanner number in the scanner system definition. Point cloud and
trajectories must be in the same coordinate system.

7. Save the laser points in LAS or TerraScan Fast Binary format which are able to store a scanner
number for each laser point. 

8. Split trajectories to create separate trajectory lines for each drive path.

9. Make sure that the drive path numbering of the laser points matches trajectory numbers
(TerraScan Deduce using time command).

10. Remove unnecessary points from the point cloud, e.g. from stops, sharp turns or long range
measurements.

11. Classify points on hard planar ground surface close to the trajectory lines (by centerline) and
maybe point on building walls (by range above scanner).

12. Search tie lines of type Section lines on vertical walls.

13. Search tie lines of type Section lines on flat ground.

14. (Optional) Add more tie lines manually if the automatically found tie lines do not give a
good result. This may be the case if the drive pattern was not optimal for the calibration task.

15. Run Find Tie Line Match and solve for heading, roll, and pitch for the whole data set.
Separate scanners if your system contains multiple scanners.

16. Add the reported correction values to the correction values used when generating the point
cloud in step 2.

MLS Project workflow

For mobile scanning projects, the quality of GPS positioning and thus, the quality of the
trajectory is usually not as good and constant as for airborne projects. This is caused by GPS
failures due to large buildings, trees, rock formations, etc. along the roads or rails. The
positioning accuracy of the trajectory can vary a lot during a drive session. Thus, the dominant

https://terrasolid.com/guides/tscan/setscannersystems.html
https://terrasolid.com/guides/tscan/toolmanagetrajectories.html
https://terrasolid.com/guides/tscan/mwreadpoints.html
https://terrasolid.com/guides/tscan/trjsplitatlasergaps.html
https://terrasolid.com/guides/tscan/mwdeduceusingtime.html
https://terrasolid.com/guides/tscan/trjcreatemacro_forstopsandturns.html
https://terrasolid.com/guides/tscan/crbyrange.html
https://terrasolid.com/guides/tscan/crbyrange.html
https://terrasolid.com/guides/tscan/crbycenterline.html
https://terrasolid.com/guides/tscan/crbyrange.html
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error source for inaccurate data is the trajectory xyz positioning which shows up close to the
scanner location.

Positional adjustment of mobile laser data in TerraMatch is based on tie line observations.
These are typically collected on flat ground and/or on high intensity features such as paint
markings.

A tie line observation can utilize ground control points or it can be for internal comparison only
(multiple drive passes seeing the same location). It is recommended to measure ground control
points along the road or other survey corridor at regular distances. The distances between
control measurements can vary depending on the required accuracy level and the accuracy of
the trajectory. Internal tie line observations should be added between the control
measurements whenever the same location has been seen by multiple drive paths.

Ground control points can be located on corners of strong paint markings, at end points of thin
strong paint markings or in the center of weaker paint markings. The latter type of control
points is then used for partial xy control.

Instead of using paint markings for control measurements, signal markers of a specific pattern
can be used as ground control points. This has the advantage that the software can find a bright
signal marker on a dark surface automatically based on the intensity information of the laser
points. See Signal markers category for more information about signal markers in TerraMatch.

More information about the different tie line types and the positional adjustment of mobile
laser scanner project data can be found in Sections Tie line types and Fluctuating corrections
with tie lines.

General project strategy

The general strategy of a mobile scanning project can be outlined as follows:

1. Collect some control measurements.

2. Execute LiDAR / image survey. Drive every place at least twice.

3. Check the system calibration.

4. Find locations of bad trajectory accuracy using color by RMS values for trajectories. Compare
the drive paths visually.

5. Collect additional control measurements at locations where the trajectory positioning is bad.

6. Adjust xyz positioning of the laser data by matching drive paths to each other and to control
measurements. This probably involves several processing steps.

7. Remove less accurate data, e.g. long range measurements where short range measurements
exist, and cut off overlapping drive paths.

8. Continue processing the data according to the project requirements.
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MLS to ALS matching

This Chapter outlines example workflows for matching MLS data to ALS data. The ALS data is
used as reference assuming that the positioning is accurate. The MLS data positioning may be
inaccurate due to positional errors described in Section MLS project workflow. The MLS and ALS
data sets may be collected at different points of time and cover the same area.

The described methods may also work for matching any point cloud to another reference point
cloud. However, the most common case is probably that an older ALS data set exists and a
newly collected MLS point cloud needs to be matched to this ALS data set. The methods are
only suitable for improving the positioning of the newer point cloud up to the accuracy level of
the older/reference point cloud.

Cloud to cloud matching

This method tries to match one point cloud to a reference point cloud by using only planar
surfaces that are detectable in both point clouds. This requires a good amount of points that
represent the planar surfaces. Best candidates for matching an MLS point cloud to an ALS point
cloud are the ground, mainly for vertical matching, and building walls for horizontal matching.
Horizontal matching is only possible if there are enough points from vertical walls also in the
ALS point cloud.

1. Set the TerraScan project for the ALS point cloud as the reference project for the MLS project.
See Reference project exists option in the Project information dialog of TerraScan. If loaded
points are used, the reference points can be loaded into TerraScan with the Read reference
points command. If a project block is loaded, the Load reference points option must be
switched on.

2. Compute normal vector and dimension attributes for the MLS data set by using either the
macro step or the menu command for loaded points in TerraScan.

3. Start Define tie lines. In the Tie line settings dialog, set the class numbers of potential point
classes (such as ground, walls, etc.) in the ALS and MLS point cloud as Cloud classes.

4. Start the cloud-to-cloud tie line search in TerraMatch.

5. Check worst tie point positions and delete, if bad. Filter bad tie lines, if necessary.

6. Solve fluctuating corrections using a smooth curve.

7. Apply correction to MLS data.

You may write a new copy of the data set.

This matching method can be extended by introducing Known Xy tie points for a better
horizontal match, especially if there are not enough building walls that can be used. The
additional tie points for horizontal matching may be produced as described in the Using
orthophotos and ground points section.

https://terrasolid.com/guides/tscan/prjnewproject.html
https://terrasolid.com/guides/tscan/mwreadreferencepoints.html
https://terrasolid.com/guides/tscan/mwreadreferencepoints.html
https://terrasolid.com/guides/tscan/mwopenblock.html
https://terrasolid.com/guides/tscan/macomputenormalvectors.html
https://terrasolid.com/guides/tscan/mwcomputenormalvectors.html
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Using objects

Objects that are detectable in both point clouds, such as poles, can be used to match an MLS
point cloud to a reference point cloud. TerraMatch can find tie lines for objects, if points from
the single objects are grouped and if groups of one object type are classified into a separate
class (e.g. each pole is one point group and all poles are in point classes "MLS Poles" and "ALS
Poles", respectively). The shape of the object is not considered when the software finds the
groups in the different lines. Therefore, the search works also for other types of objects than
poles.

1. Make sure that the line numbers in the ALS and the MLS point clouds are distinguishable.

2. Assign groups and classify points on objects that you want to use for matching. This must be
done for both, the MLS and ALS point clouds. See TerraScan User Guide for more information
about grouping and classification.

3. Start Define tie lines. In the Tie line settings dialog, set the class numbers of objects in the
ALS and MLS point cloud as Object classes.

4. Start Search tie lines and search for Group objects. The software places Xyz tie points for
objects.

5. Check tie lines. Check worst tie point positions and delete, if bad.

6. Select Fix lines command and define the line number range of the ALS point cloud. This
defines the ALS lines as reference for matching the MLS lines and the type of the tie points is
changed to Known xyz.

7. Select Find tie line fluctuations tool to match the MLS lines to the ALS point cloud.

Using orthophotos and ground points

Orthophotos or intensity images and ALS ground points can be used as reference for matching
MLS data. The orthophotos or intensity images may provide features for collecting tie points for
XY correction while the ground points can be used for collecting tie points for Z correction.

1. Attach orthophotos or intensity images as raster reference in TerraPhoto.

2. Collect Known xy tie points or lines manually from any objects that can be sees in the
attached raster images and the MLS point cloud (corners of paint markings, manhole covers,
paint lines, etc.). The known XY location is derived from the raster images and TerraMatch
computes the horizontal difference between the MLS data and the known location.

3. Use Report gaps tool to see if there are longer Xy gaps. Add tie lines in places of long gaps if
possible.

4. Solve fluctuating Xy correction.

5. Apply correction to MLS data.

https://terrasolid.com/guides/tscan/mwassigngroups.html
https://terrasolid.com/guides/tscan/index.html
https://terrasolid.com/guides/tphoto/rrefattachfiles.html


TerraMatch User Guide  © 2024 Terrasolid Ltd

34Tool Reference > MLS to ALS matching > Using orthophotos and ground points

You may write a new copy of the data set.

6. Check for remaining internal XY mismatch. If there is any, apply another internal XY
correction derived from Wall tie lines or another tie line type applicable to the data set.

7. For collecting Z tie points/lines, you can use, for example, the trajectories of the MLS data
set. Draw the xy-corrected trajectories into the CAD file. Drape the lines to the ALS ground
points. The trajectory lines now represent the ground level of the ALS data set.

8. Select trajectory lines draped to the ALS ground points.

9. Select Import points / From selected vectors and collect Known Z points. Each vertex of the
selected lines becomes a tie point.

10. Delete tie line observations with longer than about 8.0 m range. For elevation adjustment,
use only observations close to scanner.

11. Check worst tie point positions and delete, if bad. Filter bad tie lines, if necessary.

12. Solve fluctuating Z correction using a smooth curve.

13. Apply correction to MLS data.

You may write a new copy of the data set.

https://terrasolid.com/guides/tscan/trjdrawintodesign.html
https://terrasolid.com/guides/tscan/tooldraplinearelement.html
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Working with tie lines

The tie line mode is started with the Define Tie Lines
tool. The tool opens the Tie lines window.

The window provides pulldown menus with
commands for working with tie lines. These
commands are described on the following pages. If a
tie line file is loaded, it shows for each tie line the
tie line type and the following information in
columns 1-5:

1 strip number

2 scanner number

3 time stamp

4 XY mismatch at tie line location

5 Z mismatch at tie line location

The Define Tie Lines tool can also arrange the views
in the CAD file in a way that is suitable for working
with tie lines. The view setup includes:

· Full view - all tie lines are displayed in a top view.

· Entry view - one selected tie line position is
displayed in a horizontal section or top view. This
view is used for viewing or placing close-to-
horizontal tie lines manually.

· Detail view - one selected tie line with all its
positions is displayed in a horizontal section or
top view.

· Wall entry view - one selected tie line position is displayed in a vertical section view. This
view is used for viewing or placing close-to-vertical tie lines manually.

· Wall detail view - one selected tie line with all its positions is displayed in a vertical section
view.

The views are updated automatically depending on the selected tie line type.

Asterisk symbol in the scanner column indicates points from multiple scanners were used to
fit the observation

Tie line types

There are different types of tie lines which can be created depending on the objects and
features available in the laser data set. An overview of the tie line types is given in the
following table and examples are shown below in another table.

ABBREVIATIONS
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(G)CP - (ground) control point h - heading x - easting

ALS - airborne laser scanning data r - roll y - northing

MLS - mobile laser scanning data p - pitch z - elevation

TIE LINE TYPE
PLACEMENT
METHOD

POSSIBLE
LOCATIONS

ADDED VALUE
FOR SOLVING

INPUT DATA

Ground point
· manual · end point of

paint markings
on the ground

· circular objects
on the ground

· h r p

· xy z

· high point
density ALS

· MLS

Known xyz point
Known xy point

· import from
text file or
selected
vectors

· automatic/ma
nual

· CP on bright
signal marker
on dark hard
surface
(horizontal or
vertical
surface)

· GCP on
endpoints of
paint markings
on the ground

· CP defined on
target objects

· Xyz point if
reference
lines are
defined

· h r p

· absolute xy z
or xy

· high point
density ALS

· MLS

· signal marker
definition or
target object
definition

· GCP text file or
vector data

Known z point
· import from

text file or
selected
vectors

· manual

· GCP on the
ground
without
known xy

· h r p

· absolute z

· ALS

· MLS

· GCP text file or
vector data

Xyz point
· automatic · objects

represented
by grouped
and classified
points

· absolute xy z · ALS

· MLS

Xy point
· manual · building

corners

· poles

· h

· internal xy

· high point
density ALS

· MLS

Elevation point
· import from

text file or
selected
vectors

· surfaces · internal z · ALS

· MLS
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TIE LINE TYPE
PLACEMENT
METHOD

POSSIBLE
LOCATIONS

ADDED VALUE
FOR SOLVING

INPUT DATA

· half-automatic

Ground line
· manual · along paint

markings on
the ground

· h r p

· xy z

· high point
density ALS

· MLS

Plane point
· automatic

search
· surfaces · h r p

· xy z

· high point
density ALS

· MLS

Section line

· flat ground
· automatic

search

· manual

· flat, hard
surfaces

· r

· z

· ALS

· MLS

· flat ground
classification

Section line

· surface
· automatic

search

· manual

· surfaces · h r p

· z

· ALS

Section line

· vertical walls
· automatic

search

· manual

· building walls

· vertical poles

· h r p

· xy z

· MLS

Known line
· import from

text file

· automatic/ma
nual

· point on linear
paint markings

· h

· r p (ALS)

· xy z

· high point
density ALS

· MLS

Roof
intersection line

· automatic
search

· intersection of
two roof
surfaces

· h r p

· xy z

· ALS

· building
classification

EXAMPLES

Known xyz or xy point Known line

Known z point  Plane point
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EXAMPLES

Ground point Ground line

Section line - flat ground Section line - surface

Section line - vertical wall Roof intersection line

Xy point Elevation point

 

Fluctuating corrections with tie lines

Besides the correction of systematic shifts, tie lines can be used for applying corrections that
change over time (fluctuating corrections, drifts). This is essential for correcting local drifts of
the trajectory solution which occur, for example, if there is a failure of GPS signal during a flight
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or drive. Fluctuating corrections are the most important part of improving the accuracy of
mobile laser data, but they are useful for airborne data as well.

If no control measurements are involved, the software computes a guessed location for the tie
line feature which corresponds to the average of the feature location between the laser data
strips. If the trajectory solution provides estimates of the positional accuracy for each drive
pass, these estimates translate to weight factors when computing the average location. This
results in lower accuracy strips getting a bigger correction and better accuracy paths getting a
smaller correction.

If a control measurement is used, the observed correction is the difference between the tie
line feature location in the laser data and the location of the control measurement.

The actual correction for the laser data is applied as a correction curve which changes over time.
The correction curve is built by computing a correction for each tie line observation. The
correction is a linear interpolation between two consecutive observations.

Exaggerated xyz correction vectors for one strip.

The user can specify how much the correction curve is smoothed. The smoothing of the
correction curve involves the accuracy estimates for trajectory positions. Bigger corrections
values are applied for positions where the accuracy estimate is worse. A factor determines,
how fast the corrections curve changes can be. A small factor results in a smoother curve. This
should be used if the tie lines are not so good and may contain outliers. A bigger factor results
in a less smooth curve and the single tie line observations get more influence in the final
solution. This should be used for good tie lines.

If no smoothing is applied, each tie line observation fully effects the final correction values.
This is recommended for checking the tie lines and finding out erroneous tie lines. Otherwise, a
smoother correction curve is less sensible to remaining inaccurate tie line observations. No
smoothing may also be used if correction values are computed based on accurate tie points
collected from ground control points for which the exact xyz coordinate values are known.

File pulldown menu

The File pulldown menu contains commands for creating, opening and saving tie line files, for
restoring observations, for importing control measurements, for searching tie lines
automatically, and for creating a statistical report.



TerraMatch User Guide  © 2024 Terrasolid Ltd

40Tool Reference > Working with Tie Lines > File pulldown menu

TO CHOOSE MENU COMMAND

Create a new tie line file New

Open a tie line file Open

Save an existing tie line file Save

Save tie lines to a new file Save as

Restore observations from a tie line file Restore observations

Import control points as known lines Import known lines

Import control points as known or elevation
points

Import points

Search tie lines automatically Search tie lines

Search cloud-to-cloud tie lines Search cloud-to-cloud

Create a statistical report from tie lines Output report

Clean all

Clean all command is used to remove all undefined positions from loaded tie lines. It performs
the same action for all tie lines as the Clean command for a selected tie line.

To clean undefined positions from loaded tie lines:

1. Select Clean all command from the File pulldown menu.

2. Click OK to the Alert dialog.

This removes all undefined positions from the tie lines. An information dialog shows the
amount of deleted tie lines and tie line positions.

Fix lines

Fix lines command sets certain lines as fixed. As a result, the fixed lines are used as reference
lines for matching other lines.

This can be used, for example, to match an MLS point cloud to an ALS point cloud. The line
numbers of the two point clouds must be distinguishable. After searching tie lines, fix the lines
of the ALS point cloud in order to use it as reference. Then, the lines of the MLS point cloud can
be matched to the ALS data by using Find tie line match or Find tie line fluctuations tools.

To fix lines:

1. Select Fix lines command from the File pulldown menu.

This opens the Fix lines dialog:
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2. Select settings and click OK.

This sets the given lines as fixed.

SETTING EFFECT

Lines Line number(s) that are fixed and used as
reference for matching other lines.

Import known lines

Import known lines command starts the import of control measurements that have been
measured on linear paint markings. The import results in tie lines of the type Known line which
provide a partial xy control.

The control measurements have to be stored in a text file where each line includes the
separated x, y, and z coordinates for one control point.

The command requires that a project is loaded in TerraScan where the laser data provides the
input for placing the tie lines.

To import control measurements as known lines:

1. (Optional) Select a vector element which defines the direction in which paint markings run if
you want to use the automatic tie line placement mode.

2. Select Import known lines command from the File pulldown menu.

This opens the Import Known Lines dialog:
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SETTING EFFECT

Entry mode Defines how tie lines for control
measurements are placed:

· Manual - all positions are digitized
manually.

· Auto line search - the software places the
tie lines automatically.

Line length Length of a tie line that the software places
automatically. This is only active if Entry mode
is set to Auto line search.

Angle within Maximum angle difference between observed
tie line and selected vector element. This is
only active if Entry mode is set to Auto line
search.

3. Select settings and click OK.

This opens another dialog for selecting the text file with control measurement coordinates.

4. Select the text file and click Open.

If the entry mode is Manual, the control measurements are added to the tie line list in the
Tie lines window. Continue with placing the tie line locations manually.

If the entry mode is Auto line search, the software tries to place the tie lines automatically at
the location of the control measurements. Continue with checking the tie lines and placing
tie lines manually where the automatic line search has failed.

Import points

Import points command starts the import of control measurements that have been measured
on corners or end points of paint markings, on signal marker locations or on target objects. The
import results in tie lines of the type Known xyz, Known xy, Known z, or Elevation point.

The control measurements can be provided in a text file where each line includes the
separated x, y, and z coordinates for one control point. Another option are point elements
drawn in the CAD file at the control measurement locations.

The command requires that a project is loaded in TerraScan where the laser data provides the
input for placing the tie lines. If signal markers are used for placing Known xyz or xy points, the
shape of the signal marker must be defined in TerraMatch Settings.

To import control measurements as points:

1. (Optional) Select the control points in the CAD file if you want to import the control points
based on selected vectors.
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2. Select From text file or From selected vectors command from Import points command of the
File pulldown menu.

This opens the Import Points dialog:

SETTING EFFECT

Point type Type of tie lines that are created from the
control measurements.

Signal marker Signal marker or target object name defined in
TerraMatch Settings. Required for importing
Known xyz or Known xy points.

Rotation Defines the rotation for a signal marker:

· Free - the signal marker can be rotated
freely compared to the travel direction.

· Travel direction - the rotation of the signal
marker is fixed. The travel direction is
extracted from the closest trajectory.

Min contrast Intensity contrast between bright parts of a
signal marker and the dark background.

Use Laser points used for placing the tie lines:
Project points (Not UAV) or Loaded points.

Laser project Path to a TerraScan project. This is only active
if Use is set to Project points.

Fit radius Area within which points are used to calculate
the tie line location.

Require Point density required for placing the tie line.
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SETTING EFFECT

Max angle Maximum allowed angle of the surface at a tie
line location.

3. Define settings and click OK.

If the import is based on selected vectors, the software starts the import and places the tie
lines at the control measurement locations. Continue with checking the tie lines and placing
tie line positions manually where the automatic placement failed.

If the import is based on text file, another dialog opens for selecting the text file.

4. Select the text file and click Open.

This starts the import and the software places tie lines at the control measurement locations.
After the import has finished, an information dialog is shown. It displays the number of
created known points vs. the number of control measurements found in the text file or
selection set.

5. Continue with checking the tie lines and placing tie line positions manually where the
automatic placement failed.

New

New command empties the tie line window and thus, opens a new tie line file. It also removes
the active tie lines from the memory.

Open

Open command lets you open a tie line file from the hard disk. Opening a tie line file replaces
any active tie lines with tie lines stored in the file.

Output report

Output report command displays a statistical report that is created based on the active tie lines.
The content of the report varies depending on the types of tie lines that are available for
calculating the statistics. The report can include information about:

· average mismatches in 3d, xy, z

· average leaning of walls

· statistics for known points/lines including amount of tie points/lines; transformation value
recommendations; average magnitude, RMS values, maximum values, observation weights
for x, y, and z

· statistics for internal observations including amount of tie points/lines; average magnitude,
RMS values, maximum values, observation weights for x, y, and z

· average magnitudes per line for x, y, and z
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· average magnitudes per trajectory group

A text file can be saved or the report can be printed from the Tie line report window by using
the Save as text file command or Print command from the File pulldown menu. The window
size can be changed using the commands from the View pulldown menu.

Reduce to single line

Reduce to single line command reduces tie lines to single line observations. As a result, each
tie line is placed in only one strip. This is useful for solving calibration issues of a multi-scanner
system because trajectory drift issues do not effect the solution for the whole data set
anymore.

To reduce tie lines to single lines:

1. Collect tie lines with setting Separate scanners on. See Define Tie Lines for more
information.

2. Select Reduce to single line command from the File pulldown menu.

A dialog is shown which asks for confirmation of the step.

3. Click OK in order to reduce the tie lines.

4. Save the tie lines into a new tie line file.

Restore observations

Restore observations command restores original observations from a tie line file that has been
saved earlier. It can be used, for example, to restore the original observations after applying
corrections temporarily and removing bad tie lines.

To filter bad tie lines and restore observations:

1. Collect tie lines and save them into a file.

2. Solve correction(s).

3. Apply Correction to the loaded tie lines.

4. Search for worst observations and remove bad tie lines.

Erroneous tie lines usually stand out more clearly after corrections have been applied.

5. Restore original observations from the tie lines file saved in step 1.

6. Save the filtered tie lines.
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Save

Save command lets you save changes in the active tie lines to an already existing tie line file.

Save as

Save as command saves active tie lines to a tie line file. By default, tie lines are stored in a
binary file with the extension .TIL.

The user can enforce the storage of tie lines in a text file by typing the extension .TXT in
addition to the file name in the Save tie lines dialog. This is only recommended if the tie line
file needs to be opened in x32 TerraMatch or another software that can not read the binary
format for tie lines.

Search tie lines

Search tie lines command opens the Search tie lines dialog from which the automatic tie line
search can be started. With the automatic tie line search you can search for tie lines of various
types.

The automatic tie line search can be based either on laser points loaded into TerraScan or on a
TerraScan project. Tie line search can also run as macro action in TerraScan. In this case, a
settings file has to be stored from the Search tie lines dialog.

The different tie line types are searched for in different laser point classes depending on the
settings in the Define Tie Lines dialog:

· Vertical walls - wall classes

· Group objects - object classes

· Paint lines - ground classes

· Planar points - ground classes

· Flat ground - ground classes

· Surface lines - ground classes

· Roof intersections - roof classes

· Paint line corners - ground classes

The tie line settings can be changed between several tie line searches using the Settings
command from the View pulldown menu. When searching first for one tie line type and then
for another, the new tie lines are added to the active tie lines at the end of the tie line list.

To search tie lines:

1. Select Search tie lines command from the File pulldown menu.

This opens the Search tie lines dialog:

https://terrasolid.com/guides/tscan/masearchtielines.html
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2. Define settings and click OK.

The software starts the search for tie lines. As a result, tie lines of the selected type are
added to the list of active tie lines. The amount of tie lines found is displayed in an
information dialog after the search is completed.

SETTING EFFECT

Use Laser points used for placing the tie lines: Project
points (not UAV) or Loaded points .

Ignore first/intermediate echo locations If on, locations where there are laser points of first
or intermediate echo types are ignored.

Laser project Path to a TerraScan project. This is only active if
Use is set to Project points.

Save results after each block If on, the tie lines are saved automatically into a
file after the search is completed for a block of a
project. This is only active if Use is set to Project
points.

Find vertical walls Search for tie lines on vertical walls or structures
within the Wall classes defined in the settings.

· Spacing - distance between two tie line
locations. The value determines the maximum
density of the tie lines.

· Length - length of a tie line.

· Depth - depth of a section where the software
tries to fit the tie line to the laser points.

· Max angle - maximum allowed angle off from
vertical for a tie line placed on a vertical
structure.

Find group objects Search for tie lines based on groups of points that
represent a certain object type. Objects are
defined by classified and grouped points in
TerraScan. Each object must be assigned to one
group and groups of one object type must be
classified into a separate class.

· Match radius - maximum distance between a
point in the object group in one line and the
closest point in the object group in another line.

Find paint lines Search for tie lines on bright paint markings using
a selected vector of known points along the center
of paint marking.

· Length - length of a tie line.

· Max angle - maximum allowed angle off from
average between the tie lines at the same
location.

Find planar points Search for tie lines on planar surfaces within the
Ground classes defined in the settings.
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SETTING EFFECT

· Spacing - distance between two tie line
locations. The value determines the maximum
density of the tie lines.

· Radius - size for point sampling footprint in local
plane extraction.

· Max slope - maximum allowed angle off from
horizontal for a plane fit.

· Tolerance - distance tolerance between points
and plane equation for outlier filtering.

· Max angle - maximum allowed angle off from
average between the tie lines at the same
location.

Find flat ground Search for tie lines on flat ground or horizontal
surfaces within the Ground classes defined in the
settings.

· Spacing - distance between two tie line
locations. The value determines the maximum
density of the tie lines.

· Direction - direction of a tie line relative to the
movement direction: Along movement or
Perpendicular.

· Length - length of a tie line.

· Depth - depth of a section where the software
tries to fit the tie line to the laser points.

· Max angle - maximum allowed angle off from
average between the tie lines at the same
location.

Find surface lines Search for tie lines on surfaces within the Ground
classes defined in the settings.

· Spacing - distance between two tie line
locations. The value determines the maximum
density of the tie lines.

· Direction - direction of a tie line relative to the
movement direction or terrain slope: Along
movement, Perpendicular, or Slope direction.

· Length - length of a tie line.

· Depth - depth of a section where the software
tries to fit the tie line to the laser points.

· Max angle - maximum allowed angle off from
average between the tie lines at the same
location.

Find roof intersection lines Search for tie lines along intersections of roof
planes within the Roof classes defined in the
settings.

· Length - length range of a tie line.

· Min width - minimum width of the roof planes
on both sides of the tie line.
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SETTING EFFECT

· Planarity - distance tolerance between point
and plane equation of the planar roof patch it
belongs to.

· Min slope - minimum slope off from horizontal
of the roof planes.

· Require - number of observations required for
accepting a tie line location. Minimum is 2
observations (from 2 strips).

Find paint corners Search for tie lines based on intensity
(alternatively reflectance or amplitude) values in
MLS point clouds. The software tries to identify
corners of paint markings on the road surface. This
requires good intensity values. If there are
systematic issues with intensity values (such as
weeker intensity for points at a longer distance
from scanner or smaller angle of incidence), an
intensity correction may be required, e.g. with the
Find intensity correction tool of TerraMatch.

· Spacing - distance between two tie line
locations. The value determines the maximum
density of the tie lines.

· Pixel size - pixel size of the intensity raster that
is internally created from each drive path. Use a
smaller size than the scan line distance in the
point cloud.

· Laser footprint -  for each pixel in the intensity
raster, a circular area of the given radius is used
to compute a distance-weighted average
intensity value from the laser points. 

· Use - point attribute used for placing the tie
lines. Alternatives for the Intensity attribute are
the Reflectance or Amplitude attributes (e.g.
from Riegl Extra Bytes).

· Paint value - intensity values that represent
bright paint markings in a point cloud. The
minimum value is given in the text field. This
needs to be tested for each point cloud, e.g.
with the TerraScan option to classify points by
intensity.

· Only between trajectories - if on, the search for
tie lines is reduced to the area between
trajectories which corresponds to the road
center area. 

File / Load settings

Load settings command can be used to open a previously stored settings file.

https://terrasolid.com/guides/tscan/crbyintensity.html
https://terrasolid.com/guides/tscan/crbyintensity.html
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To open a tie line search settings file:

1. Select Load settings command from the File pulldown menu.

This opens the Tie line settings file dialog, a standard Windows dialog for opening files.

3. Select a settings file and click Open.

File / Save settings

Save settings command lets you save tie line search settings into a file. The file can be used by
the TerraScan macro action for searching tie lines. The file can also be loaded into TerraMatch
using the Load settings command from the Search tie lines dialog. The settings are stored into a
text file with the extension .SET. The settings file includes settings from the Seach tie lines
dialog as well as settings from the Define tie lines dialog.

To save a tie line search settings file:

1. Define settings for the tie line search in the Search tie lines dialog.

2. Select Save settings command from the File pulldown menu.

This opens the Tie line settings file dialog, a standard Windows dialog for saving files.

3. Define a location and name for the settings file and click Save.

Search cloud-to-cloud

Search cloud-to-cloud command searches tie lines for matching a mobile ground-based (MLS)
point cloud to a reference point cloud, such as airborne laser data. The tie lines are placed for
the MLS point cloud in user-defined time intervals. For each time interval, the software
computes an XYZ shift for matching the MLS data better to the reference data. Consecutive
observations must not differ too much in correction values, and only observations that do not
differ too much from closest more reliable observations are accepted. As a result, a fluctuating
XYZ correction curve can be computed from the tie lines.

Requirements for the cloud-to-cloud matching process:

· Both data sets, the MLS data set for matching and the reference data set must include points
on vertical surfaces, such as building walls. Only with points on wall-like surfaces the
software is able to compute an XY correction automatically. Otherwise, additional tie points
are required for XY correction, for example Known XY points derived from orthophotos or
from ground control points.

· The reference point cloud must be available together with the MLS point cloud. In a
TerraScan project, the reference point cloud is defined as reference project in the project
definition of the MLS project. See Reference project exists option in the Project information
dialog of TerraScan. If loaded points are used, the reference points can be loaded into
TerraScan with the Read reference points command. If a project block is loaded, the Load
reference points option must be switched on.

https://terrasolid.com/guides/tscan/masearchtielines.html
https://terrasolid.com/guides/tscan/prjnewproject.html
https://terrasolid.com/guides/tscan/mwreadreferencepoints.html
https://terrasolid.com/guides/tscan/mwopenblock.html
https://terrasolid.com/guides/tscan/mwopenblock.html
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· The normal vector and dimension attributes must be computed for the MLS data set. The
cloud-to-cloud matching is derived from points of Planar dimension. The computation can
be done with TerraScan, either with a macro step or with a menu command for loaded
points. The attributes can be stored permanently in TerraScan Fast Binary files.

To search cloud-to-cloud tie lines:

1. Select Search cloud-to-cloud command from the File pulldown menu.

This opens the Search Cloud-to-cloud Tie Lines dialog:

2. Define settings and click OK.

The software starts the search for tie lines. As a result, tie lines are added to the list of active
tie lines. The amount of tie lines found is displayed in an information dialog after the search
is completed.

Although the tie lines can be displayed on top of the point cloud, there is not much use in
checking the tie lines. Each tie line drawing just represents the given time interval for which
the software tries to compute the XYZ shift. The tie line drawing does not represent any
specific XYZ location in the point clouds.

3. Use the Find tie line fluctuations tool in order to compute, check, and save the XYZ correction
curve for matching.

SETTING EFFECT

Use Laser points used for placing the tie lines:
Project points (not UAV) or Loaded points.

Laser project Path to a TerraScan project. This is only active
if Use is set to Project points.

Neighbours Area for which points from neighbouring
blocks are used. This is only active if Use is
set to Project points.

Time Interval Time difference between consecutive tie
lines.

https://terrasolid.com/guides/tscan/macomputenormalvectors.html
https://terrasolid.com/guides/tscan/mwcomputenormalvectors.html
https://terrasolid.com/guides/tscan/mwcomputenormalvectors.html
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SETTING EFFECT

Search radius Determines the 3D radius around a point
within which the software searches for
points in the reference data set. The search
radius is taken into account after the
maximum XY shift from the tie lines settings
and some thinning are already applied to the
MLS data set. The value relates to the point
density and point-to-point spacing in the
data sets. The value should be larger than the
point-to-point spacing in the MLS data set
and the reference data set. If the value is
chosen too big, the tie line search is very
slow.
Recommended values: 0.25 m if matching
MLS to ALS data, up to 1.0 m if more distant
and sparse points on walls in MLS data should
be used for matching, < 0.25 m if both data
sets are really dense, e.g. when matching
MLS data to another MLS reference data set.

Max xyz rate This first value determines the minimum
change in the correction curve independently
of the trajectory accuracy.
The second value determines how fast the
correction curve is allowed to change in
relation to the trajectory accuracy and
travelled distance. A smaller factor leads to
slow changes in the correction curve (= more
smoothing applied), a larger factor allows
faster changes in the correction curve (= less
smoothing applied).

Line pulldown menu

The Line pulldown menu contains commands for adding tie lines manually or half-
automatically, for modifying the type of a tie line, for cleaning up tie lines, and for deleting tie
lines.

TO CHOOSE MENU COMMAND

Add tie lines of a specific type manually or
half-automatically based on laser data that is
loaded in TerraScan. See Tie line types for
more information about the different tie line
types.

Add ground point
Add xy point
Add elevation point
Add known point
Add ground line
Add section line
Add known line
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TO CHOOSE MENU COMMAND

Modify the type of a tie line Edit

Delete undefined tie line positions Clean

Delete tie lines Delete

Add elevation point

Add elevation point command lets you place a tie line of the type Elevation point.

To add an elevation point:

1. Select Add elevation point command from the Line pulldown menu.

This opens the Add elevation point dialog:

SETTING EFFECT

Require Point density required for placing the tie
point.

Fit radius Area within which laser points are used to
calculate the tie point’s elevation.

2. Define settings that fit to the laser data.

3. Select an approximate location for the tie point in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions.

Add ground line

Add ground line command lets you place a tie line of the type Ground line.
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To add a ground line:

1. Select Add ground line command from the Line pulldown menu.

This opens the Add ground line dialog:

SETTING EFFECT

Entry mode Defines how the tie line is placed:

· Manually - all positions are digitized
manually.

· Auto line search - only the first position is
placed manually, the other positions are
found automatically.

Require Point density required for placing the tie
point.

2. Select settings that fit to the laser data.

3. Select an approximate location for the tie line in the Full view.

This updates the Entry view and Detail view and adds the tie line to the list.

4. (Manual mode) Place the tie line in the Entry view according the the laser data for each tie
line position.

OR

5. (Auto line search mode) Place the tie line in the Entry view according the the laser data for
the first tie line position. The software tries to find the other tie line positions automatically.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions.

Add ground point

Add ground point command lets you place a tie line of the type Ground point.

To add a ground point:

1. Select Add ground point command from the Line pulldown menu.

This opens the Add ground point dialog:



TerraMatch User Guide  © 2024 Terrasolid Ltd

56Tool Reference > Working with Tie Lines > Line pulldown menu

SETTING EFFECT

Sources Determines where the software looks for data
for placing a tie point:

· At mouse click - data from lines/scanners
with required point density around the data
click location is considered. This is the
preferred setting.

· Within max error - data from all
lines/scanners are considered for tie point
placement if they are within the maximum
error limits given in the tie line settings.
This slows down the tie point placement
and should be used only in exceptional
cases (e.g. tunnel data sets with large
mismatch).

Surface If a point cloud contains multiple surfaces at
the location of a tie point, the tie point is
fitted to:

· High - the highest surface.

· Dominant - the dominant surface. Use this
in all cases where there is only one surface
in a point cloud at a tie point location.

· Low - the lowest surface.

Require Point density required for placing the tie
point.

Fit radius Area within which laser points are used to
calculate the tie point’s elevation.

Display circle If on, a circle of the specified Diameter is
displayed at the mouse pointer location. This
helps to place a tie point accurately, for
example on circular objects.

2. Define settings that fit to the laser data.

3. Select an approximate location for the tie point in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.
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4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions.

Add known line

Add known line command lets you place a tie line of the type Known line. This requires that
control measurements are available and drawn as point elements into the CAD file.

To add a known line:

1. Select Add known line command from the Line pulldown menu.

This opens the Add known line dialog:

SETTING EFFECT

Entry mode Defines how the tie line is placed:

· Manual - all positions are digitized
manually.

· Auto line search - only the first position is
placed manually, the other positions are
found automatically.

Number Number of the known line. Counts up
automatically.

2. Define settings.

3. Snap to the known point and draw a line at the approximate location of the tie line in the Full
view.

This updates the Entry view and Detail view and adds the tie line to the list.

4. (Manual mode) Place the tie line in the Entry view according the the laser data for each tie
line position.

OR
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4. (Auto line search mode) Place the tie line in the Entry view according the the laser data for
the first tie line position. The software tries to find the other tie line positions automatically.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions.

Add known point

Add known point command lets you place a tie line of the type Known xyz, Known xy, or Known
z point. This requires that control measurements are available and drawn as point elements
into the CAD file.

To add a known point:

1. Select Add known point command from the Line pulldown menu.

This opens the Add known point dialog:

SETTING EFFECT

Type Known tie point type:

· Known xyz - xyz coordinates are used for the
tie point.

· Known xy - xy coordinates are used for the
tie point.

· Known z - z coordinate is used for the tie
point.

Require Point density required for placing the tie
point.

Fit radius Area within which points are used to calculate
the tie point location.

2. Select settings that fit to the laser data and to the known points that are used.

3. Snap to the control point drawn in the CAD file in order to define the location for the tie line
in the Full view.
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This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions. You may also change the type of the tie point using the Edit command, for
example from Known xyz to Known z, if you are not able to place the tie point at the accurate
xy location.

Add section line

Add section line command lets you place a tie line of the type Section line.

To add a section line:

1. Select Add section line command from the Line pulldown menu.

This opens the Add Section Line dialog:

SETTING EFFECT

Section depth Depth of the section that is used for fitting
the tie line to the laser data.

2. Define settings that fit to the laser data.

3. Select an approximate location for the tie line in the Full view.

This updates the Entry view and Detail view or the Wall entry view and Wall detail view, and
adds the tie line to the list.

4. Place the tie line in the Entry view or Wall entry view according the the laser data for each tie
line position.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions.

Add xy point

Add xy point command lets you place a tie line of the type Xy point.
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To add an xy  point:

1. Select Add xy point command from the Line pulldown menu.

This opens the Add Xy Point dialog:

SETTING EFFECT

Require Point density required for placing the tie
point. Refers to points in the Wall classes
field in the Tie Line Settings dialog.

Display circle If on, a circle of the specified Diameter is
displayed at the mouse pointer location. This
helps to place a tie point accurately, for
example on circular objects.

2. Define settings that fit to the laser data.

3. Select an approximate location for the tie point in the Full view.

This updates the Entry view and Detail view and adds the tie point to the list.

4. Place the tie point in the Entry view according the the laser data for each tie point position.

If you are not able to place all tie point positions, you can skip a position by selecting the
next observation for this tie point. Then use the Clean command to remove undefined
positions.

Clean

Clean command is used to remove undefined positions from a tie line. There are places where
a tie line can not be defined for some strips due to obstructions, too low point densities, or
inappropriate viewing angles. This results in undefined positions which should be deleted from
the tie line list.

To clean undefined positions from a tie line:

1. Select the tie line or one of its positions.

2. Select Clean command from the Line pulldown menu.

This removes all undefined positions from this tie line.
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The Clean all command can be used to remove undefined positions from all loaded tie lines.

Delete

Delete command is used to delete tie lines from the list. In contrast to Delete command from
the Position pulldown menu, this command deletes the tie line completely.

COMMAND EFFECT

Selected tie line The selected tie line is deleted.

Inside fence All tie lines inside a fence or selected
polygon are deleted.

Outside fence All tie lines outside a fence or selected
polygon are deleted.

Edit

Edit command can be used to change the type of a tie line.

To change the tie line type:

1. Select the tie line.

2. Select Edit command from the Line pulldown menu.

This opens the Tie Line Information dialog:

3. Select a new tie line Type from the selection list.

4. Click OK.

This changes the type of the tie line and updates the information in the tie line list.
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Position pulldown menu

The Position pulldown menu includes commands for correcting tie line positions manually, for
identifying tie lines, for deleting tie line positions, for finding bad tie lines, and for identifying
the position of the scanner at a tie line location.

A tie line position refers to a tie line at one specific flight or drive path.

TO CHOOSE MENU COMMAND

Define the position of a tie line manually Enter position

Select a tie line from a CAD file view Identify

Delete tie line positions Delete

Find the tie line with the biggest mismatch
value

Find worst

Find tie lines with mismatch values up to a
certain threshold

Find
Find next

Show the scanner position for a tie line
location

Show scanner

Remove closeby tie line observations Thin by travel distance

Remove bad tie lines automatically Filter bad

Delete

Delete command is used to delete positions of tie lines. In contrast to the Delete command
from the Line pulldown menu, this command may not delete a tie line completely but only
those positions that meet the defined settings.

COMMAND EFFECT

Selected position The selected position of a tie line is deleted.

By line Tie line positions of selected strip(s) are
deleted.

By scanner Tie line positions of selected scanner(s) are
deleted.

By criteria Tie line positions that fit to specified criteria
are deleted.

Bad line numbers Tie lines that do not match a trajectory line
number are deleted. Trajectory line numbers
are checked from the active trajectory
directory in TerraScan.
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Delete / By criteria

By criteria command deletes tie line positions that fit to specific criteria. The criteria are
defined in the command's dialog. The dialog also shows the number of effected tie lines and tie
line positions as soon as the criteria is specified. Only tie line positions that fit to all criteria set
in the dialog are deleted.

To delete tie line positions by  criteria:

1. Select By criteria from the Delete command of the Line pulldown menu.

This opens the Delete Positions by Criteria dialog:

2. Define one or several criteria for tie line removal.

The number of effected tie lines and tie line positions is displayed dynamically in the dialog.

3. Click OK.

This deletes the tie line positions. A dialog shows the number of deleted tie lines and tie
line positons.

SETTING EFFECT

Type Tie line positions of a specified type. The list
contains all tie line types.

Line Tie line positions of a given line number.

Group Tie line positions that belong to the given
trajectory group. This relies on the trajectory
group attribute defined in TerraScan.
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SETTING EFFECT

Scanner Tie line positions of a given scanner number.

Range Tie line positions within the given 3D
distance range from the trajectory.

3D mismatch Tie line positions with a 3D mismatch value
within the given range.

Xy mismatch Tie line positions with a Xy mismatch value
within the given range.

Z mismatch Tie line positions with a Z mismatch value
within the given range.

Slope Tie line positions with angle to the horizontal
plane within the given range.

Enter position

Enter position command lets you place a tie line position manually. This can be used for
correcting the position of a selected tie line, for example when the automatic placement did
not work accurately.

To enter the position of a tie line:

1. Select the tie line position for which you want to place the tie line.

2. Load laser data at the tie line location.

3. Select Enter position command from the Position pulldown menu.

4. Digitize the new tie line location in the Entry view according to the laser data.

This updates the location of the tie line and the values in the tie line list.

Filter bad

Filter bad command removes bad tie line observations automatically. This helps to reduce the
manual effort for checking bad tie lines after the automatic tie line search.

The routine first runs the Find tie line fluctuations process on the tie lines using the given
method for smoothing and solving the selected parameters. Then, it removes tie line
observations with the largest residual mismatches. These two processes are repeated until
there are no mismatch distances in tie line observations bigger than the given filter limit.

The filter limit should be defined in a way that valuable tie lines are not removed. It must not
be set to a too small value, especially if heading, roll, and/or pitch corrections have to be
solved.



TerraMatch User Guide  © 2024 Terrasolid Ltd

65Tool Reference > Working with Tie Lines > Position pulldown menu

To filter bad tie lines automatically :

1. Select Filter bad command from the Position pulldown menu.

This opens the Filter Bad dialog:

2. Define settings and click OK.

This starts the filtering process. An information dialog shows the number of deleted tie lines
and tie line positions after the process has finished. Depending on the amount of tie lines,
the process may take some time.

SETTING EFFECT

Filter limit Maximum allowed mismatch distance in tie
line observations. This acts as a threshold for
stopping the filtering process.

Keep all manual positions If on, manually placed tie lines are not
effected by the filtering process.

Correction Determines the method for smoothing the
correction curve in the internal Find tie line
fluctuations process:

· Restricted curve - smoothing based on
trajectory accuracy estimates is applied. The
amount of smoothing is determined by the
Max rate factor and effected by the accuracy
of trajectory positions.

· Smooth curve - smoothing based on a 1D
Gaussian filter is applied.

Max rate Determines how fast the corrections curve
changes can be. A smaller factor results in a
smoother curve. Values can range between
0.1 and 100.0, the default value is 2.0. This is
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SETTING EFFECT

only available if Correction is set to Restricted
curve.

Range Distance forward and backward from a tie line
observation within which correction values
are averaged. Values can range between 0.1
and 100.0, the default value is 50. This is only
active if Correction is set to Smooth curve.

Solve Xy Solves for a fluctuating xy correction.

Solve Z Solves for a fluctuating z correction.

Solve heading Solves for a fluctuating heading correction.

Solve roll Solves for a fluctuating roll correction.

Solve pitch Solves for a fluctuating pitch correction.

Find

Find command is used for searching tie lines that have a mismatch larger than a specific
threshold value. The threshold can relate to different mismatch values, such as elevation, xy,
3D, angular, or wall angle mismatch.

To find tie lines:

1. Select Find command from the Position pulldown menu.

This opens the Find Tie Line dialog:

2. Define settings and click OK.

The first tie line position with a mismatch larger than the defined threshold is selected in the
list.

3. Check the tie line and make corrections, if necessary.

4. Continue checking tie lines with Find next command.
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SETTING EFFECT

Find by Mismatch values as search criteria:

· Elevation mismatch - in CAD file master
units.

· Xy mismatch - in CAD file master units.

· 3D mismatch - in CAD file master units.

· Angle mismatch - degree off from average.

· Wall angle - degree off from vertical.

Mismatch > Threshold value for searching bad tie lines.

Find next

Find next command is used to check tie lines with a mismatch larger than defined in the Find tie
line dialog of Find command. It requires that the Find command has been used to define the
parameters for the search of bad tie lines. After that, you can check all tie lines that meet the
search criteria by using the Find next command.

Check tie lines that meet specific search criteria:

1. Define the parameters for the tie line search with Find command.

2. Check the first selected tie line and make corrections, if necessary.

3. Select Find next command from the Position pulldown menu.

The next tie line position with a mismatch larger than the defined threshold is selected in
the list.

4. Continue with step 3 until the end of the tie line list is reached.

Find worst

Find worst command is used to select the tie line with the largest mismatch or residual value
from the list. It helps to detect incorrect tie lines or tie lines with exceptionally high mismatch
values.

To check the worst tie line in  the list:

1. Select Find worst command from the Position pulldown menu.

This opens the Find Worst Position dialog:
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2. Define settings and click OK.

This selects the tie line in the list that has been identified as the worst according to the given
settings. The selected tie line is also shown in the CAD file views used for displaying the tie
lines.

SETTING EFFECT

Find by Method of finding the worst tie line:

· Mismatch - the tie line with the largest
mismatch value (XY or Z) is shown.

· Residual - the tie line with the largest
residual mismatch after applying a
fluctuating correction is shown.

Smoothing Distance forward/backward from a tie line
observation along the trajectory direction
within which smoothing is applied. This
effects the fluctuating correction curve for the
residual computation. This is only active if
Find by is set to Residual.

Solve Xy|Z|heading|roll|pitch If on, a fluctuating correction is computed for
the selected value(s). This is only active if Find
by is set to Residual.

Identify

Identify command is used to identify a tie line in a CAD file view with a mouse click. The
corresponding tie line is selected in the tie line list.

To identify  a tie line:

1. Select Identify command from the Position pulldown menu.

2. Move the mouse pointer inside a CAD file view.

The tie line closest to the mouse pointer is highlighted.

3. Place a data click in order to select the tie line in the list.
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Show scanner

Show scanner command can be used to check the scanner position when the system captured
the data at a selected tie line location. This is useful, for example for determining whether a tie
line is placed at a short or long distance from a scanner.

To show the scanner position:

1. Select a tie line position in the tie lines list.

2. Select Show scanner command from the Position pulldown menu.

3. Move the mouse pointer inside a CAD file view.

A line is displayed between the selected tie line location and the scanner position.

4. Place a data click in order to draw the line into the CAD file.

Thin by travel distance

Thin by travel distance command removes tie line observations that are very close to each
other. The distance between tie lines is measured as travel distance along a trajectory.

To thin tie lines based on travel d istance:

1. Select Thin by travel distance command from the Position pulldown menu.

This opens the Thin by Travel Distance dialog:

SETTING EFFECT

Dimension Type of control provided by tie lines to be
thinned:

· Any - any dimension control.

· Xyz - full 3D (XYZ) control.

· Xy - horizontal (XY) control.

· Z - vertical (Z) control.

Spacing
Minimum allowed distance between
consecutive tie lines.
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2. Define settings and click OK.

This removes tie line observations that are closer to each other than the given distance. An
information dialog shows the number of deleted tie lines and tie line positions.

Tools pulldown menu

The Tools pulldown menu contains commands for transforming tie lines, for drawing tie lines
into the CAD file and for checking gaps between consecutive tie lines.

TO CHOOSE MENU COMMAND

Transform tie lines Transform tie lines

Change the format of tie line time stamps Convert time stamps

Draw tie lines into the CAD file Draw observations

Create a list of locations without tie lines Report gaps

Convert time stamps

Convert time stamps command can be used to convert the format of time stamps. Supported
conversions are:

INPUT FORMAT CONVERTED FORMAT

GPS seconds-of-week GPS standard time

GPS time

GPS standard time GPS seconds-of-week

GPS time

GPS time GPS seconds-of-week

GPS standard time

GPS seconds-of-day GPS seconds-of-week

GPS standard time

GPS time

Unix time GPS seconds-of-week

GPS standard time

GPS time

UTC seconds-of-day GPS seconds-of-week

GPS standard time
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INPUT FORMAT CONVERTED FORMAT

GPS time

UTC seconds-of-week GPS seconds-of-week

GPS standard time

GPS time

The conversion may be necessary if data was processed earlier using one time stamp format
and then, the time stamp format of the trajectories has been changed for some reason.  It is
essential that time stamps of tie lines are the same as for trajectories and point cloud data.

To convert time stamps:

1. Select Convert time stamps command from the Tools pulldown menu.

This opens the Convert Tie Line Time dialog:

3. Define settings and click OK.

This converts the tie line time stamps to the new format. Save the tie line file in order to
make the modification permanent.

SETTING EFFECT

Method Defines the computation method of
modifying time stamps:

· Source and target system - conversion from
one time format to another.

· Multiply and add constant - constant value
by which time stamps are multiplied or that
is added to current time stamps.

Current values Original time stamp format of the trajectory
positions. This is only active if Method is set
to Source and target system.
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SETTING EFFECT

Convert to Target time stamp format. This is only active if
Method is set to Source and target system.

Survey date Date when the data was captured for which
the tie lines have been derived. The format is
day/month/year (dd/mm/yyyy). This is only
active for the conversion from GPS seconds-
of-week or UTC seconds-of-day/week to GPS
standard time or GPS time.

Multiply by Factor by which current time stamps are
multiplied. This is only active if Method is set
to Multiply and add constant.

Add Value to add to GPS time stamps when
converted from UTC seconds-of-day time
stamps. Refers to the leap-seconds that by
which GPS time is ahead of UTC time. This is
only active for the conversion from UTC
seconds-of-day to any GPS time format.
Value to add to current time stamps if Method
is set to Multiply and add constant.

Deduce line numbers If on, line numbers for the tie lines are
deduced from the trajectories loaded in
TerraScan. This is only successful, if the time
stamps correspond to each other in both, tie
lines and trajectories.

Draw observations

Draw observations command draws tie line observations into the CAD file. The observations are
drawn as point or line elements using the active level and symbology settings of the CAD file.

To draw tie line observations:

1. Select Draw observations command from the Tools pulldown menu.

This opens the Draw observations dialog:
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2. Define settings and click OK.

This draws the tie line observations into the CAD file.

SETTING EFFECT

Type Tie line type to be drawn: Any or one of the
tie line types available in TerraMatch.

Only line If on, only tie lines of the given flight line
number are drawn.

Only scanner If on, only tie lines of the given scanner
number are drawn.

Report gaps

Report gaps command creates a list of locations where there are no tie lines for given types of
corrections.

The gaps found in active tie lines are displayed in a dialog. The user controls of the dialog let
you sort the list of gaps in different ways, show the location of a gap, and rebuild the list after
changes have been made to the tie lines.

To create a report of gaps between tie lines:

1. Select Report gaps command from the Tools pulldown menu.

This opens the Report gaps dialog:

2. Define settings and click OK.

SETTING EFFECT

Gap type Determines which locations are defined as
gaps:

· Xy - places with no tie lines for XY
correction.

· Xy longitudinal - places with no tie lines for
XY correction along the travel direction.
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SETTING EFFECT

· Xy perpendicular - places with no tie lines
for XY correction perpendicular to the travel
direction.

· Z - places with no tie lines for Z correction.

Gap length Maximum allowed distance between tie lines.
If the distance is bigger, it is reported as a gap.

This opens another Report Gaps dialog which shows the list of gaps:

The list contains the chain (trajectory) number, the position of the gap along the chain, and the
length of the gap.

You can use the options in the Sort by list to sort the list:

· Chain and position - primarily by the chain number, secondarily by increasing positions along
the chain.

· Chain and length - primarily by the chain number, secondarily by decreasing lengths of the
gaps.

· Length - by decreasing lengths of the gaps.

Show location - highlights the location of a gap. Select a row in the list and click on the button.
Move the mouse pointer inside a CAD file view. This highlights the selected gap by drawing a
temporary dashed line. Place a data click in order to center the view at the gap’s center point.
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Rebuild list - recomputes gaps after tie lines have been changed, for example, after new tie
lines were added.

Transform tie lines

Transform tie lines command is used to transform the coordinates of tie lines. The
transformation must be defined in Coordinate transformations category in the TerraScan
Settings.

To transform tie lines:

1. Select Transform tie lines command from the Tools pulldown menu.

This opens the Transform Tie Lines dialog:

2. Define settings and click OK.

This transforms the tie lines to the new projection system. You may save the transformed tie
lines into a new file.

SETTING EFFECT

Apply to Data to transform:

· Known coordinates - transforms known
point coordinate values (= values given by
some other survey method).

· Laser positions - transforms observation
coordinate values (= values extracted from
laser data).

· Both - transforms known coordinates and
laser positions.

Transformation Name of the transformation to be applied.
The name is defined in Coordinate
transformations category of TerraScan
Settings.

View pulldown menu

The View pulldown menu contains commands for defining the settings for tie lines, for
displaying tie lines and for displaying tie line attributes in the Tie Lines window.

https://terrasolid.com/guides/tscan/settransformations.html
https://terrasolid.com/guides/tscan/settransformations.html
https://terrasolid.com/guides/tscan/toolsettings.html
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TO CHOOSE MENU COMMAND

Change the settings for tie line placement Settings

Define how tie lines are displayed in CAD file
views

Display mode

Select attributes that are visible in the Tie
Lines window

Fields

Display mode

Display mode command lets you define how tie lines are drawn in different CAD file views. For
each view, you can select the coloring method, line weight, and limit the display of tie lines to
certain criteria.

To set the display  of tie lines:

1. Select Display mode command from the View pulldown menu.

This opens the Tie line display mode dialog:

2. Define settings and click Apply.

This applies the settings to the selected view. You can continue with the definition of
settings for another view.

SETTING EFFECT

View Number of the CAD file view for which the
settings are applied. The list contains view
numbers 1-8.
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SETTING EFFECT

Color by Determines the coloring method:

· Do not draw - no tie lines are draw.

· Line - tie lines are colored by line number.

· Scanner - tie lines are colored by scanner
number. This makes only sence if tie lines
are collected separately for different
scanners.

Weight Line weight for drawing tie lines. The list
contains the line weights of the CAD
platform.

Only type If on, only tie lines of the given type are
drawn:

· Any known - tie lines of any “known” tie
line type, such as Known xyz, Known xy,
Known z, Known line.

· Any common - tie lines of any tie line type
that is not “known”.

· <type> - tie lines of the selected type.

Only dimension If on, only tie lines of the given dimension
are drawn:

· Xyz - tie lines that provide full 3D (XYZ)
control.

· Xy - tie lines that provide horizontal (XY)
control.

· Z - tie lines that provide vertical (Z)
control.

Only line If on, only tie lines of the given line
number(s) are drawn. You can define
several line numbers by using minus and
comma, for example, 1-5,7,10.

 
Use the Pick visible line button to identify a
trajectory line by a data click. The number of
the line closest to the data click is used in
the Only line field.

Only scanner If on, only tie lines of the given scanner
number(s) are drawn. You can define
several scanner numbers by using minus
and comma, for example, 1-3,5.

Only mismatch If on, only tie lines within the given
mismatch value range are drawn. Define the
minimum and maximum mismatch value for
drawing tie lines in the text fields.
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SETTING EFFECT

Only slope If on, only tie lines with the given slope
value range are drawn. Define the minimum
and maximum slope value for drawing tie
lines in the text fields. 0.0 refers to
horizontal, 90.0 to vertical direction. Tie
points are not drawn if this option is on.

Settings

Settings command opens the Tie line Settings dialog. It is the same dialog as opened by the
Define Tie Lines tool.

Fields

Fields command lets you select which attributes are displayed in the Tie Lines window.

To select visib le fields:

1. Select Fields command from the View pulldown menu.

This opens the View Tie Line Fields dialog:

2. Select fields you want to see in the list of loaded points and click OK.

FIELD NAME DESCRIPTION

Line Line number. May refer to the flight line or
drive path number in ALS or MLS point
clouds. 

Scanner Number of a scanner. This is displayed if
scanners are separated for placing tie line
observations. An asterisk (*) is displayed if
scanners are not separated.

Time Point of time of a tie line observation.
Derived from the time stamps of the point
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FIELD NAME DESCRIPTION

cloud. Expressed in seconds.

Xy mismatch Horizontal mismatch at the location of a tie
line observation. This may represent the
mismatch between a known point and the tie
line observation or the mismatch between
several tie line observations.

Z mismatch Vertical mismatch at a tie line observation.
This may represent the mismatch between a
known point and the tie line observation or
the mismatch between several tie line
observations.
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Match tool box

The tools in the TerraMatch tool box are used to define user settings, to perform matching of
laser data and to access online help.

 

 

TO USE 

Change user settings Settings

Define coordinate range and resolution Define Coordinate Setup

Find correction values for laser data Find Match

Apply known correction values Apply Correction

Correct fluctuating elevation differences Find Fluctuations

Match forward/backward measurements of
elliptical scans

Match Forward and Backward

Find range corrections caused by high
intensity measurements or specific scan
angles

Find Range Corrections

Find intensity corrections based on the
distance from the scanner

Find Intensity Correction

Find Mirror Angle Correction

Measure how well strips match Measure Match

View information about TerraMatch About TerraMatch

View online help Help on TerraMatch
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About TerraMatch

About TerraMatch tool opens a dialog which shows information about TerraMatch and about
the license.

From this dialog, you can open the License information dialog which looks the same for all Terra
Applications:

Use the Request license button to start the online registration for node-locked licenses.

More information about license registration is available on the Terrasolid web pages.

Apply Correction

Apply Correction tool applies known correction values to a data set. You can type in the
correction values manually or they can be loaded from a TerraMatch corrections file saved by
the following tools:

· Find Match

· Find Fluctuations

· Match Forward and Backward

· Find Range Corrections

· Find Intensity Correction

· Find Tie Line Match

· Find Tie Line Fluctuations

The tool allows to apply corrections to several types of data, such as laser data, tie lines,
trajectories, and image lists in TerraPhoto.

In the process of applying corrections, the software interpolates values between observation
locations, such as tie lines, relative to the travel distance. This method is more accurate than
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interpolation relative to time, especially for ground-based mobile scanning data sets where
stops may occur.

General procedure for apply ing corrections:

1. Select the Apply Correction tool.

This opens the Apply corrections dialog:

2. Define settings and click OK.

This opens subsequent dialogs where you can enter or verify the correction values to apply.

3. Click OK in order to start the process.

A report window displays the results of the process. The report is written during the process,
if fluctuating corrections are applied to project points.

SETTING EFFECT

Apply to Data set to correct:
· Project points - all blocks referenced by a

given project file. (not UAV)

· Loaded points - points loaded into
TerraScan.

· Tie line file - tie lines in a file saved on a
hard disk.

· Loaded tie lines - active tie lines in
TerraMatch.

· Loaded image list - active image list in
TerraPhoto.

· Trajectories - active trajectories in
TerraScan.

Laser project TerraScan project file to apply corrections to.
This is only active if Apply to is set to Project
points.

Write to Directory into which to write the modified
block binary files or the modified trajectory
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SETTING EFFECT

files. This is only active if Apply to is set to
Project points or Trajectories.

Trajectory dir Directory containing TerraScan trajectory files.

Corrections Source of correction values:

· Enter manually - corrections values are
typed manually.

· Load from file - reads correction values from
a TerraMatch corrections file.

File File containing correction values. This is only
active if Corrections is set to Load from file.

Correct Type of correction to apply:

· Whole data set - one value to apply to the
whole data set.

· Individual lines - separate correction values
for each strip.

This is only active if Corrections is set to Enter
manually.

Key-in command syntax for Apply correction:

apply=points/project/tiefile/tielines/images

trajdir=trajectory_folder

project=project_file

writedir=result_folder

corrections=correction file

run=0/1

Example:

apply=project trajdir=c:\data\trajectory_scan project=c:\data\laser02\tscan.prj writedir=c:
\data\laser03 corrections=c:\data\calib\fluct_xyz.tms run=0

Define Coordinate Setup

Define Coordinate Setup tool sets up coordinate system values that a Terra Application uses for
laser points and images. It determines the coordinate range inside which all data must be
located and the resolution to which coordinate values are rounded. The coordinate setup is
stored into the active CAD file and is used by all Terra Applications.

Terra Applications use signed 32 bit integer values for storing coordinates of laser points and
images. This has the advantage of using only 12 bytes of memory for the coordinate information
of each point. You can control how accurately coordinate values are stored by defining how big
each integer step is.
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If, for example, one integer step is equal to one millimeter, all coordinate values are rounded
to the closest millimeter. At the same time it would impose a limitation on how far apart points
can be or how big the coordinate ranges are. Millimeter steps produce a coordinate cube which

has a size of 232 millimeters or 4294967.296 meters. If the origin of the coordinate system is at
[0.0, 0.0, 0.0], the coordinate ranges are limited to values between -2147483 and +2147483. If
necessary, you can fit the coordinate ranges to your data by modifying the Easting and Northing
coordinates of the coordinate system origin.

If one integer step is equal to one centimeter, the coordinate values can range from -21 million

to +21 million which is large enough for most coordinate systems.

To define the coordinate setup:

1. Select the Define Coordinate Setup tool.

This opens the Define Coordinate Setup dialog:

2. Define settings and click OK.

This modifies the coordinate system values used by all Terra Applications in the active CAD
file.
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Find Fluctuations

Find Fluctuations tool compares short intervals of each strip against other overlapping strips. It
computes elevation corrections for each strip based on a surface-to-surface comparison
method. Each short time interval of a strip gets its own correction value. For the final correction
file, the correction values can be averaged in order to get a smoother correction curve.

Find Fluctuations tool requires that laser points have time stamps and that the same pre-
processing steps have been applied for the laser data as for the Find Match tool. You have to
classify ground in each strip separately before this tool can be used. It does not require that
trajectories are loaded. It uses trajectory information only to determine the relative accuracies
of different strips.

The tool can run on loaded points in TerraScan or on a TerraScan project.

General procedure for finding and apply ing fluctuating corrections:

1. Select Find Fluctuations tool.

This opens the Find Fluctuations dialog:

2. Select settings and click OK.
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SETTING EFFECT

Solve Type of solution to find: Elevation.

Use Points to use in find fluctuations: Loaded
points or Project points (not UAV).

Laser project TerraScan project file which defines the
blocks to use in comparison. This is only
active if Use is set to Project points.

Trajectory dir Directory containing TerraScan trajectory
files.

Use classes Classes to use for comparison and weight
factors to apply.

Interval Time interval used by the software to
calculate a correction value.

Max triangle Maximum length of a triangle created for the
surface-to-surface comparison.

Ignore limit Limit value for differences between strips
that the software tries to match. The values
should be a bit higher than the largest
mismatch between strips. Larger mismatches
are treated as gross errors and therefore not
included in the calculation.

This opens the Fluctuations dialog:

The dialog shows the list of strips on the left and a graph of corrections for the selected strip
on the right. The yellow bars in the graph represent the time intervals for which a correction
value is calculated. The correction value for a selected time interval is shown on top of the
graph.

3. Check the fluctuating corrections using the buttons and menu commands from the
Fluctuations dialog.
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4. Save a corrections file using the Save results command from the File pulldown menu. The
correction file allows to apply corrections later to the laser data with the Apply Correction
tool.

OR

4. Apply corrections directly using the Apply button in the Fluctuations dialog.

This opens the Apply Fluctuation Corrections dialog:

5. Define settings and click OK.

This applies the fluctuating corrections to the laser data.

SETTING EFFECT

Correction Method of averaging the correction values:

· One step - no averaging applied.

· Average of 3 - three observations are
averaged.

· Average of 5 - five observations are
averaged.

· Average of 7 - seven observations are
averaged.

· Average of line - the average value of a strip
is used as a correction value.

Factor Factor multiplied to the calculated correction
values. A value of 50% means that the original
correction values are multiplied by 0.5.

Max correction Maximum allowed correction that is applied
to the laser data.

Fluctuations dialog for surface matching

The Fluctuations dialog provides several buttons and menu commands for visualizing, analyzing
and saving the fluctuating correction values.

Show location button is used to highlight the location of a time interval in a CAD file view.
Select the time interval in the Fluctuations dialog graph. Click the button and move the mouse
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pointer inside a CAD file view. The selected time interval is dynamically highlighted. Place a
data click inside the view in order to center the view at the location of the time interval.

Identify button is used to select the location of a time interval in the Fluctuations dialog graph.
Click on the button and place a data click in a CAD file view. This selects the time interval
closest to the data click in the Fluctuations dialog graph.

Edit / Find big correction values

Find big correction values command selects locations with big correction values. It can find the
largest value or values that are larger than a defined threshold.

To locate big correction values:

1. Select Find command from the Edit pulldown menu.

This opens the Find Fluctuation dialog:

2. Select settings and click OK.

The time interval with the maximum correction value or the first value larger than the
defined Dz threshold is shown in the Fluctuations dialog and selected in the graph.

Edit / Find next

Find next command can be used after the Find command has been used with Find set to Large
value and a Dz threshold. The command selects the next time interval along the graph with a
correction value larger than the defined threshold.

View / Display settings

Display settings command defines settings for the graph display in the Fluctuations dialog. This
includes settings for the size of the yellow bars representing the time intervals and the
maximum range of correction values. In addition, settings for displaying the correction curve
and applying some averaging to the correction values are defined.

To define settings for the display  of fluctuation corrections:

1. Select Display settings command from the View pulldown menu.
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This opens the Display Settings dialog:

2. Define settings and click OK.

This applies the new settings to the graph display.

SETTING EFFECT

Step size Defines the display size of one time interval
(width of the yellow bar) in the Fluctuations
dialog graph.

Range max Maximum correction value range displayed in
the Fluctuations dialog graph.

Display correction curve If on, the correction curve is displayed as blue
line in the Fluctuations dialog graph.

Correction Method of averaging the correction values:

· One step - no averaging applied.

· Average of 3 - three observations are
averaged.

· Average of 5 - five observations are
averaged.

· Average of 7 - seven observations are
averaged.

· Average of line - the average value of a strip
is used as correction value.

Factor Factor multiplied to the calculated correction
values. A value of 50% means that the original
correction values are multiplied by 0.5.

Max correction Maximum allowed correction that is applied
to the laser data.

When a correction file is saved from the Fluctuations dialog, the settings for a correction
curve and for averaging correction values are used as defined in the Display settings dialog.
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View / Statistics

Statistics command shows a dialog with some statistical values for the fluctuations per strip and
for all strips. The statistics includes minimum, maximum, and average correction value, median,
average magnitude and standard deviation.

You can save a text file or print the statistics using commands from the File pulldown menu in
the Statistics dialog. The dialog size can be changed with commands from the View pulldown
menu.

Find Intensity Correction

Find Intensity Correction tool solves intensity corrections based on the range of a point from
the scanner. This is useful for mobile laser data if the intensity values of points systematically
increase with the point’s 3D distance from the scanner.

Finding intensity corrections requires laser data from overlapping strips or scanners and
preferable from a hard surface, such as a road surface. The points on the surface must be
classified into a separate class. The correction is computed per scanner by comparing intensity
values of one scanner with all other points within a given sample radius.

The tool provides correction values for range intervals in a TerraMatch correction file. This
correction file can then be used to apply the corrections to the laser data of a project. There is
also an option of smoothing the correction values.

Intensity correction should be done when strips have been matched but the overlap between
strips is not yet cut off. It may help to improve the result of extracting vector elements for paint
markings automatically or for generating intensity ortho images with TerraScan.

To find intensity  correction:

1. Load laser data into TerraScan from an area that is suitable for finding intensity corrections.

2. Select the Find Intensity Correction tool.

This opens the Find Intensity Correction dialog:
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3. Define settings and click OK.

SETTING EFFECT

Minimum range Minimum 3D distance from the scanner used
for computing the intensity correction
values.

Maximum range Maximum 3D distance from the scanner used
for computing the intensity correction
values.

Range interval Distance interval for computing correction
values. One correction value is computed for
each interval within Minimum range and
Maximum range.

Sampling radius Distance around each point for comparing the
point’s intensity value of one scanner with
the average intensity values of all other
points.

Trajectory dir Directory containing TerraScan trajectory
files.

Use classes Classes to use for finding intensity
corrections.

This opens the Intensity Correction Results dialog:
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4. Define settings.

SETTING EFFECT

Scanner
Number of the scanner for which to apply
intensity correction values.

Smoothing
Number of smoothing rounds to apply to the
correction curve.

Fill ends

How to assign correcion values to points for
which there is no observation within the given
Minimum and Maximum range:

· Approach zero - correction values linearly
approach zero.

· Closest observation - uses correction value
of the closest range interval with an
observation.

File / Save correction
Saves a TerraMatch correction file for being
used in the Apply Correction tool.

5. Save the corrections using the Save corrections command from the File pulldown menu.

6. Close the Intensity Correction Results dialog.

7. Apply the range corrections to laser data using the Apply Correction tool.

Find Match

Find Match tool analyzes the mismatch in laser data and solves for correction parameters. The
tool utilizes the surface-to-surface matching method described in Find match vs. Tie Lines.

You can run Find Match either on points loaded into TerraScan or on a TerraScan project. When
running on a project, TerraMatch automatically scans through all project blocks during one
iteration round.
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Before you run Find Match, you must have performed a number of pre-processing steps which
can be outlined as follows:

· Import trajectories into TerraScan.

· Split any trajectories which overlap themselves.

· Import time-stamped laser points into TerraScan.

· Make sure that strip numbering of laser points matches trajectory numbers.

· Classify low points.

· Classify ground separately for each strip.

· (Optional) Classify ground to another class in places which are best suited for comparison.

· (Optional) Classify buildings.

· (Optional) Smoothen ground surface if most of it is asphalt or some other hard surface.

You can select the classes which to use in surface-to-surface comparison and how much weight
to apply to each class. This makes it possible to manually classify locations which have sloped
surfaces and to apply a higher weight value to those classes.

You may choose from the following strategies:

· Use ground points only and use High weight value for ground.

· Use good surfaces only. Classify suitable locations manually to Building class or Sloped
ground class. Use High weight value for the classes.

· Use both ground points and good surfaces. Classify suitable locations manually. Apply High
weight value to those classes and Low or Medium weight to ground class.

General procedure to find correction parameters:

1. Select the Find Match tool.

This opens the Find Match dialog:
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2. Define settings and click OK.

SETTING EFFECT

Use Points to use in comparison: Loaded points or
Project points (not UAV).

Laser project TerraScan project file which defines the blocks
to use in comparison. Selectable only when
Use is set to Project points.

Trajectory dir Directory containing TerraScan trajectory files.
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SETTING EFFECT

Correct Quality of trajectories to correct. This allows
you to keep better quality trajectories as fixed
and compute corrections for lower quality
trajectories only.

Known points Optional text file containing known points.

Progress If set to Saving intermediate results, the
software saves the solution values after each
iteration.

Results Path to the file for saving intermediate
results. This is only active when Progress is set
to Save intermediate results.

Use classes Classes to use for comparison and weight
factors to apply.

Observe every How many points to make an observation
with. Use 1 for small data sets and a bigger
value (2-5) for large data sets.

Max triangle Maximum length of a triangle created for the
surface-to-surface comparison.

Ignore limit Limit value for differences between strips that
the software tries to match. The values should
be a bit higher than the largest mismatch
between strips. Larger mismatches are treated
as gross errors and therefore not included in
the calculation.

Solve for Type of solution to find:

· Whole data set - one value per selected
correction to apply to the whole data set.

· Individual lines - separate correction values
for each strip per selected correction.

Easting shift Solves for a constant easting correction value.

Northing shift Solves for a constant northing correction
value.

Z shift Solves for a constant elevation correction
value.

Heading shift Solves for a constant heading correction value.

Roll shift Solves for a constant roll correction value.

Pitch shift Solves for a constant pitch correction value.

Mirror scale for whole Solves for a mirror scale factor. Always solved
for the whole data set, no matter what type of
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SETTING EFFECT

solution is selected in the Solve for list.

Easting drift Solves for easting correction which changes
linearly by time.

Northing drift Solves for northing correction which changes
linearly by time.

Elevation drift Solves for elevation correction which changes
linearly by time.

Heading drift Solves for heading correction which changes
linearly by time.

Roll drift Solves for roll correction which changes
linearly by time.

Pitch drift Solves for pitch correction which changes
linearly by time.

The application runs through a number of iterations which may last anything from a few
seconds to several hours depending on the size of the data set. When the iteration has
converged, the Apply results dialog opens:
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3. View the report and optionally store it as a text file.

4. Save a corrections file by using the Save corrections command from the File pulldown menu.
This enables the application of the corrections later using the Apply Correction tool. This is
the recommended workflow.

5. Click Cancel to close the dialog without applying the corrections directly.

OR

3. Check all strips to which you want to apply the correction in the lower list box.

4. Click OK to apply the corrections directly.

When using a project, you should set the directory into which the output files are written.
When using loaded points, corrections are applied to the loaded points in memory.
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Find Mirror Angle Correction

Find Mirror Angle Correction tool solves point cloud corrections dependent on scan angle. The
tool can adjust points in a cross section perpendicular to system direction of travel, thus making
it useful to fix smiling face error present in point cloud data. Corrections are solved individually
per scanner.

Finding mirror angle corrections requires laser data from overlapping strips or scanners and
preferably from a hard surface, such as a road surface. The points on the surface must be
classified into a separate class. In addition, trajectories with timestamps covering the point
cloud are required. The correction is computed per scanner by comparing mismatch to surfaces
observed by other scanners and strips.

The tool provides correction values for angle intervals in a TerraMatch correction file. This
correction file can then be used to apply the corrections to the laser data of a project. There is
also an option of smoothing the correction values. Alternatively, corrections can be applied
directly from the tool to loaded points.

To find mirror angle correction:

1. Load laser data into TerraScan from an area that is suitable for finding mirror angle
corrections.

2. Select the Find Mirror Angle Correction tool.

This opens the Find Mirror Angle Correction dialog:

3. Define settings and click OK.

SETTING EFFECT

Use classes Classes to use for finding mirror angle
corrections.

Observe every How many points to make an observation
with. Use to limit point usage with high



TerraMatch User Guide  © 2024 Terrasolid Ltd

99Tool Reference > Match tool box > Find Mirror Angle Correction

SETTING EFFECT

density clouds.

Angle limit Limit for how much normal vector of the local
plane has to differ from vector from the
location to the scanner. The purpose of this
setting is to eliminate observations where
plane normal vector and the vector to the
scanner are parallel, which means that mirror
angle shift will not result in any change on
the surface.
Usually > 10 degree value works well to filter
ambiguous observations.

Ignore limit Limit value for differences between strips
that the software tries to match. The values
should be a bit higher than the largest
mismatch between strips. Larger mismatches
are treated as gross errors and therefore not
included in the calculation.

Correction for If set to Skip central part, any adjustment
does not apply to points within specified
scan angle range.

Skip from Lower and upper limit for angle range not
adjusted. This is only available if Correction
for is set to Skip central part.

Trajectory dir Directory containing TerraScan trajectory
files.

This opens the Mirror Angle Result dialog:

4. Adjust the level of smoothing.
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SETTING EFFECT

Scanner
Number of the scanner for which to apply
intensity correction values.

Smoothing
Number of smoothing rounds to apply to the
correction curve.

File / Save correction
Saves a TerraMatch correction file for being
used in the Apply Correction tool.

File / Apply correction Apply correction to loaded points.

5. Save the corrections using the Save corrections command from the File pulldown menu.

6. Close the Mirror Angle Result dialog.

7. Apply the range corrections to laser data using the Apply Correction tool.

Find Range Corrections

Find Range Corrections tool solves range corrections for different intensity values, scanners or
angles. Very high intensity values may cause a wrong elevation value for the laser points which
leads to local inaccuracies at such locations. Usually, points with high intensity values are a bit
raised from the surrounding surface and from their correct elevation level. The system
manufacturer provides a range correction file specific for the system. The Find Range
Corrections tool can be used to adjust the values from this initial system-specific correction.

Range corrections per scanner can be used to correct little elevation differences in data from
several scanners or scan heads. This results in less noise in data collected with a multiple-
scanner system.

Range corrections per angle can be used to correct little elevation differences in data caused by
scan angles.

Finding range corrections requires laser data from a smoothly changing hard surface with
different intensities or from different scanners. The points on the surface must be classified
into a separate class. For airborne scanning, data from the airport runways with strong white
paint markings are good locations for collecting suitable data for intensity-based range
correction. For mobile scanning data or UAV data, a road or a parking space with a special
calibration mat for intensity-based range correction can be used.

The tool provides adjustment values for different intensities or scanners in a TerraMatch
correction file. The correction file can then be used to apply the corrections to the laser data of
a project. There is also an option for combining the intensity-based corrections found in
TerraMatch with a the range correction values provided by the system manufacturer.

To find range correction:

1. Load the laser data into TerraScan from the area that is suitable for finding range corrections.
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2. Select the Find Range Correction tool.

This opens the Find Range Correction dialog:

3. Define settings and click OK.

SETTING EFFECT

Solve Type of range correction:

· Intensity based range - corrections for
intensity-based range inaccuracies.

· Range per scanner - corrections for scanner-
based range inaccuracies.

· Range per angle - corrections for angle-
dependent range inaccuracies.

Max intensity Maximum intensity value for which range
corrections should be found. Common values
are 255 for 8 bit intensity, 4095 for 12 bit
intensity and 65535 for 16 bit intensity data.
This is only active if Solve is set to Intensity
based range.

Max angle Maximum scan angle value for which range
corrections should be found. This is only
active if Solve is set to Range per angle.

Use best Defines what points the software uses for
finding range corrections. The software uses
the given percentage of points with the
highest local intensity variation. This is only
active if Solve is set to Intensity based range.

Ignore limit Helps to avoid bad observations. The software
ignores observations with a elevation
difference bigger than this value.

Trajectory dir Directory containing TerraScan trajectory files.
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SETTING EFFECT

Modify classes Classes to use for finding range corrections.
Applying the correction adjusts points in these
classes.

Fixed classes Classes to use for finding range corrections.
Applying the adjustment does not modify
points in these classes.

This opens the Range Correction Results dialog.

The dialog for Intensity based range or Range per angle corrections is shown below:

SETTING / COMMAND EFFECT

Scanner Number of the scanner for which to apply
range corrections.

View Intensity value range for display:

· Whole range - whole range from 0 to Max
intensity.

· Observed range - intensity range avaiable in
the used points.

Smoothing Number of smoothing rounds to apply to the
correction curve.

Fill ends How to assign correcion values to very small or
very large intensity values for which there are
no observations:

· Approach zero - correction values linearly
approach zero.

· Closest observation - uses correction value
of the closest intensity value with an
observation.



TerraMatch User Guide  © 2024 Terrasolid Ltd

103Tool Reference > Match tool box > Find Range Corrections

SETTING / COMMAND EFFECT

File / Save correction Saves a TerraMatch correction file for being
used in the Apply Correction tool.

File / Merge with system file Adds the corrections to another correction file
provided by the system manufacturer and
saves a TerraMatch correction file for being
used in the Apply Correction tool.

The dialog for Range per scanner corrections just shows the correction value for each
scanner:

4. Define settings for Intensity based range or Range per Angle corrections.

5. Save the TerraMatch range corrections using the Save corrections command from the File
pulldown menu.

For Intensity based range or Range per angle corrections, you can also use the Merge with
system file command from the File pulldown menu in order to create a correction file that
includes system-specific corrections.

6. Close the Range Correction Results dialog.

7. Apply the range corrections to laser data using the Apply Correction tool.

Help on TerraMatch

Help on TerraMatch  tool opens the online help in the standard web browser.
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Match Forward and Backward

Match Forward and Backward tool can be used for matching flightlines from scanner systems
which measure the same location twice in a single flight pass, e.g. by elliptical scan pattern.

The tool requires that surfaces are classified per flightline with forward and backward
measurements in separate classes. It translates the differences between the forward and
backward points into corrections of heading, pitch and/or fluctuating elevation corrections
using a surface-to-surface matching method.

The Match Forward and Backward tool can use loaded points in TerraScan as well as point files
referenced by a TerraScan project. It needs TerraScan trajectories for finding a solution. It can
solve for one misalignment angle or the elevation correction at a time.

Find Forward and Backward matching corrections:

1. Select the Match Forward and Backward tool.

This opens the Match Forward and Backward dialog:
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2. Enter settings and click OK.

This opens the Fluctuations dialog. Proceed with applying corrections as described above for
Find Fluctuations tool.

SETTING EFFECT

Use Data to use for comparison:
· Project points - all blocks referenced by a

given project file. (not UAV)

· Loaded points - points loaded into
TerraScan.

Laser project TerraScan project file to apply corrections to.
This is only active if Use is set to Project
points.

Trajectory dir Directory containing TerraScan trajectory files.

Solve Parameter for which a correction is solved:
Elevation, Heading or Pitch.

Match across flightlines If on, an elevation correction is solved in a
way the matches individual flightlines to each
other as well. This is only active if Solve is set
to Elevation.

Forward class Class that contains points on surfaces from
forward scans per flightline.

Backward class Class that contains points on surfaces from
backward scans per flightline.

Interval Time interval used by the software to
calculate a correction value.
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SETTING EFFECT

Max triangle Maximum length of a triangle created for the
surface-to-surface comparison.

Ignore limit Limit value for differences between forward
and backward surfaces that the software tries
to match. The values should be a bit higher
than the largest mismatch between forward
and backward points. Larger mismatches are
treated as gross errors and therefore not
included in the calculation.

Measure Match

Measure Match tool measures how well different strips match each other. It computes the
elevation difference between surfaces from individual strips and a mean surface.

The report value can be used to determine if laser strips are matching each other better or
worse compared to an earlier measurement. You can use this tool:

· Determine if strips match each other at normal level (comparing to earlier projects).

· Determine if a modification applied to laser data was an improvement (comparing before
and after modification).

As the comparison is based on surfaces, you should normally perform ground classification on
each strip individually before running this tool. You may also classify some other suitable
surfaces such as building roofs from each strip.

Measure Match tool can use all the points from laser data files in a TerraScan project or loaded
points.

To measure how well strips match:

1. Select the Measure Match tool.

This opens the Measure Match dialog:
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2. Select rows in the list box for the classes to use in the comparison.

3. Define the other settings and click OK.

The application computes the average elevation differences between each strip and a mean
surface.

SETTING EFFECT

Use Data to use for comparison:
· Project points - all blocks referenced by a

given project file. (not UAV)

· Loaded points - points loaded into
TerraScan.

Laser project TerraScan project file to apply corrections to.
This is only active if Apply to is set to Project
points.

Max Triangle Maximum length of a triangle created for the
surface-to-surface comparison.

Ignore limit Limit value for differences between strips that
the software uses for computing elevation
differences. Larger mismatches are treated as
gross errors and therefore not included in the
calculation.

Use classes Classes to use for computing elevation
differences between individual strips and the
mean surface.
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The results are shown in the Measure Match report:

ATTRIBUTE MEANING

Average magnitude Mean value of absolute elevation difference
values.

Flightline Number of the line.

Points Amount of points included in the
computation for each line.

Magnitude Absolute value of the elevation difference
between a line and the mean surface.

Dz Mean value of the elevation difference
between a line and the mean surface.

Match Settings

Match Settings tool lets you change a number of settings controlling the way how TerraMatch
works. Selecting this tool opens the TerraMatch Settings dialog:
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Settings are grouped into logical categories. If a category in the list is selected the appropriate
controls are displayed to the right of the category list.

The settings are saved into the TerraMatch settings file in the installation directory when the
Settings dialog is closed.

The different categories and related settings are described in detail in Section TerraMatch
Settings.
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Tie line tool box

The tools in the Tie lines tool box are used to define tie line settings, to find a match solution
and fluctuating corrections based on tie lines.

 

 

TO USE

Define tie lines for matching Define Tie Lines

Find correction values using tie lines Find Tie Line Match

Find fluctuating corrections using tie lines Find Tie Line Fluctuations

Find rubbersheet correction matching data
to control points

Find Rubbersheet Fit

Define Tie Lines

Define Tie Lines tool opens the dialog for tie line settings. It is the starting point for working
with tie lines in TerraMatch.

To start the tie line mode in TerraMatch:

1. Select Define Tie Lines tool.

This opens the Tie Line Settings dialog:
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2. Define settings and click OK.

This opens the Tie line window and arranges the views for tie line work. See chapter Working
with Tie Lines for more information about how to work with tie lines.

SETTING EFFECT

Full view Number of the CAD file view for displaying a
full top view of the data when the tie point
mode is active.

Point radius Radius of a circle that is displayed in the Full
view at the location of a tie line.

Entry view Number of the CAD file view for displaying
laser data from all strips at a location of a
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SETTING EFFECT

horizontally-oriented tie line. The view is
updated whenever a tie line position is
selected in the Tie lines window.

Detail view Number of the CAD file view for displaying
laser data from one strip at a location of a
horizontally-oriented tie line. The view is
updated whenever a tie line position is
selected in the Tie lines window. In this
view, tie lines can be placed manually.

Wall entry view Number of the CAD file view for displaying
laser data from all strips at a location of a
vertically-oriented tie line. The view is
updated whenever a tie line position is
selected in the Tie lines window.

Wall detail view Number of the CAD file view for displaying
laser data from one strip at a location of a
vertically-oriented tie line. The view is
updated whenever a tie line position is
selected in the Tie lines window. In this
view, tie lines can be placed manually.

Top view length Length of top view to create for ground line
and known line tie lines.

Helping lines Length of helping lines that are displayed in
detail views when placing a tie line manually.

Arrange views automatically If on, the CAD file views are arranged on the
screen according to the settings for entry and
detail views.

Laser time gap Time difference between different lines at
the same location.

Max error xy Estimation of the maximum difference
between lines in horizontal positioning. Only
tie lines up to this distance are accepted in
automatic tie line search.

Max error z Estimation of the maximum difference
between lines in elevation positioning. Only
tie lines up to this distance are accepted in
automatic tie line search.

Fit tolerance Estimation of the noise level in the data. It
determines how tie lines are fitted to the
data of one line.

Ground classes Laser point classes for the automatic search
of Section lines on flat ground and on
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SETTING EFFECT

surfaces.

Wall classes Laser point classes for the automatic search
of Section lines on vertical walls.

Roof classes Laser point classes for the automatic search
of Roof intersection lines.

Target classes Laser point classes for the automatic search
of targets. Targets can be defined in Target
objects category of the TerraMatch Settings.

Object classes Laser point classes for the automatic search
of group objects. Objects are defined by
classified and grouped points in TerraScan.
Each object must be assigned to one group
and groups of one object type must be
classified into a separate class. See MLS to
ALS matching workflows for more
information.

Cloud classes Laser point classes for the automatic search
of cloud-to-cloud tie lines. See MLS to ALS
matching workflows for more information.

Separate scanners Of on, tie lines are placed for each scanner
separately. This is used for scanner system
calibration.

Line width Estimation of the width range of paint
markings. This is used for the automatic
search of paint lines and for placing Ground
tie lines automatically.

Trajectory dir Directory where the TerraScan trajectory files
are stored.

The settings for tie lines can be changed when the tie line mode is active using the Settings
command from the View pulldown menu in the Tie line window.

Find Rubbersheet Fit

Find Rubbersheet fit tool can be used to match data to control points. The matching is done
based on a triangulated correction model for XYZ, XY, or Z.

The tool requires tie lines that are suitable for computing the correction model. The tie lines
are collected using commands from the TerraMatch Tie line window. Suitable tie line types are
Known xyz, Known xy, or Known z.
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In the tool settings you can define how averaging is applied between closeby observations.
Further, the values for the outer corners of the correction model can be either derived from the
closest correction value or set to zero. The following figure illustrates the computation of a
rubbersheet correction model.

The tool can be used, for example, as a last adjustment step for aerial airborne laser data. After
matching the data internally, the data set is matched to control points using the rubbersheet
correction.

General procedure for finding and apply ing fluctuating corrections:

1. Select Find Rubbersheet Fit tool.

This opens the Find Rubbersheet Fit dialog:

2. Define settings and click OK.
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SETTING EFFECT

Source Source file for calculating the fluctuating
corrections:

· Active tie lines - tie lines in an open Tie line
window are used.

· Tie line file - tie lines stored in a tie line file
are used.

Tie lines Path to the tie line file that is used for
calculating the corrections. This is only active
when Source is set to Tie line file.

Trajectory dir Directory where the TerraScan trajectory files
are stored.

Solve Defines what correction values are computed:
Xyz, Xy, or Z.

Expand model Distance by which the correction model is
expanded from the observation location
closest to the data set boundary to the
outside.

Expand using Determines how the values for the outside
corners of the correction model are derived:

· Zero correction - the correction value is set
to 0.0.

· Closest correction - the correction value is
equal to the closest computed correction
value.

Max count Maximum amount of observations that are
averaged if they are located closeby.

Max distance Maximum distance between observations that
are averaged.

Merge final correction points If on, the final correction points are merged
into one correction value according to the
averaging settings.

This opens the Find Rubbersheet Correction Results dialog:
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The dialog shows the report of the correction model computation. Starting and final average
mismatch values indicate the level of improvement that can be achieved by applying the
correction model. Further, list of all correction points of the model is shown.

3. (Optional) You may draw the correction vectors into the CAD file by using the command from
the Draw pulldown menu. The commands open the Draw Correction Vectors dialog which
lets you define a scale factor for drawing the correction vectors.

4. Save a corrections file using the Save corrections command from the File pulldown menu.

You may also save the report as a text file or print it directly by using the corresponding
commands from the File pulldown menu.

5. Apply the corrections to the laser data using the Apply Correction tool.

Find Tie Line Fluctuations

Find Tie Line Fluctuations tool compares short intervals of each strip against other overlapping
strips. It computes corrections for different parameters based on tie lines. Each short distance
interval of each strip gets its own correction value. For the final correction file, the correction
curve can be smoothed.

Find Tie Line Fluctuations tool requires tie lines that are suitable for calculating fluctuating
correction values for the different parameters. The tie lines are collected using commands from
the TerraMatch Tie line window. Additionally, tie points collected in TerraPhoto based on
images can be included in the calculation. The tie points in TerraPhoto must be of types Known
depth or Depth tie points.

The smoothing of the correction curve can be done using two alternative methods:
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· Restricted curve: The smoothing of the correction curve involves the accuracy estimates for
trajectory positions. Bigger corrections values are applied for positions where the accuracy
estimate is worse. If trajectories are estimated to be very accurate, no rapid drift is modeled even

though tie l ine observations may indicate that. The Max rate factor determines, how fast the
corrections curve changes can be. A small factor results in a smoother curve. This should be
used if the tie lines are not so good and may contain outliers. A bigger factor results in a less
smooth curve and the single tie line observations get more influence in the final solution.
This should be used for good tie lines.

· Smooth curve: A 1D Gaussian fi lter is implemented to handle fi ltering of any kind of observations. It
should reduce the impact of noise but sti l l  model the drift if there are good observations. It was
developed based on MMS data with drift in XY and Z. The smoothing may allow rapid changes in the
correction curve if the tie l ine observations are accordingly. The method is suited for data sets where
there are many stops or slow-downs during the drive along the same trajectory, and when travel
distance is not changing so much (up to 4 * sigma). The averaging is performed along the neighborhood
of one trajectory, where each tie l ine observation gets in the end one time stamp.

If accuracy estimates for trajectory positions are not available, the software uses values defined
in Default trajectory accuracy category of TerraMatch Settings.

General procedure for finding and apply ing fluctuating corrections:

1. Select Find Tie Lines Fluctuations tool.

This opens the Find Tie Line Fluctuations dialog:

2. Define settings and click OK.

SETTING EFFECT

Source Source file for calculating the fluctuating
corrections:

· Active tie lines - tie lines in an open Tie line
window are used.
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SETTING EFFECT

· Tie line file - tie lines stored in a tie line file
are used.

Tie lines Path to the tie line file that is used for
calculating the corrections. This is only active
when Source is set to Tie line file.

Image tie points Determines whether tie points from
TerraPhoto are included in the calculation:

· Do not use - no tie points from TerraPhoto
are used.

· Active tie points - known depth tie points
are used if a tie point file is loaded in
TerraPhoto.

Use Defines what tie lines to use for calculating
the corrections:

· All tie lines - use all tie lines.

· Known points only - use only tie lines of
type Known xyz, Known xy, Known z and
Known line.

Trajectory dir Directory where the TerraScan trajectory files
are stored.

Correction Determines the method for smoothing the
correction curve:

· Free curve - no smoothing is applied. Each
tie line observation fully effects the
solution.

· Restricted curve - smoothing based on
trajectory accuracy estimates is applied. The
amount of smoothing is determined by the
Max rate factor and effected by the accuracy
of trajectory positions.

· Smooth curve - smoothing based on a 1D
Gaussian filter is applied.

Max rate Determines how fast the corrections curve
changes can be. A smaller factor results in a
smoother curve. Values can range between
0.1 and 100.0, the default value is 2.0. This is
only available if Correction is set to Restricted
curve.

Range Distance forward and backward from a tie line
observation within which correction values
are averaged. Values can range between 0.1
and 100.0, the default value is 50. This is only
active if Correction is set to Smooth curve.
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SETTING EFFECT

Solve Xy Solves for a fluctuating xy correction.

Solve Z Solves for a fluctuating z correction.

Solve heading Solves for a fluctuating heading correction.

Solve roll Solves for a fluctuating roll correction.

Solve pitch Solves for a fluctuating pitch correction.

This opens the Fluctuations dialog:

The dialog shows the list of strips on the left and a graph of corrections for the selected strip
on the right. The red bars in the graph represent the tie line observations from which a
correction value is calculated. The correction value for a selected observation is shown on
top of the graph.

3. Check the fluctuating corrections using the buttons and commands from the Fluctuations
dialog. The options are described in Section Fluctuations dialog for tie lines.

4. Save a corrections file using the Save corrections command from the File pulldown menu.

5. Apply the corrections to the laser data, tie lines, and other data types using the Apply
Correction tool.

Fluctuations dialog for tie lines

The Fluctuations dialog provides several buttons and menu commands for visualizing, analyzing
and saving the fluctuating correction values.

Show location button is used to highlight the location of a time interval in a CAD file view.
Select the time interval in the Fluctuations dialog graph. Click the button and move the mouse
pointer inside a CAD file view. The selected time interval is dynamically highlighted. Place a
data click inside the view in order to center the view at the location of the time interval.
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Identify button is used to select the location of a time interval in the Fluctuations dialog graph.
Click on the button and place a data click in a CAD file view. This selects the time interval
closest to the data click in the Fluctuations dialog graph.

Select tie line button is used to select a tie line observation in the Tie lines window. Select a tie
line observation in the Fluctuations dialog graph and click the button. This selects the tie line
observation in the Tie line window.

File / Display settings

Display settings command defines settings for the graph display in the Fluctuations dialog. This
includes settings for displaying correction vectors in CAD file views and for the content shown
in the graph display.

To define settings for the display  of fluctuation corrections:

1. Select Display settings command from the File pulldown menu.

This opens the Fluctuations display settings dialog:

2. Define settings and click OK.

This applies the new settings to the graph display and the vectors shown in CAD file views.

SETTING EFFECT

Scale xy Scale factor for the display of correction
vectors in xy direction.
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SETTING EFFECT

Scale z Scale factor for the display of correction
vectors in z direction.

Display all correction vectors If on, correction vectors are displayed as lines
in CAD file views. The length of the line is the
correction value at this location scaled by the
value set for Scale xy and Scale z.

Level Level number in the CAD file on which the
correction vectors are displayed.

Top view Number of the CAD file view for displaying
the correction vectors in a top view.

3D view Number of the CAD file view for displaying
the correction vectors in a 3D view.

Profile view Number of the CAD file view for displaying
the correction vectors in a profile view.

Draw Correction that is displayed in the
Fluctuations dialog graph.

Range max Maximum correction value range displayed in
the Fluctuations dialog graph.

Second Defines the display size of one second time
interval in the Fluctuations dialog graph.

Draw correction curve If on, a line element represents the
correction curve in the graph display in
addition to the correction vectors.

Draw observations If on, the tie line observations are shown in
the graph display as red dots in addition to
the correction vectors. The size of the dots is
determined by the Weight selection.

Find Tie Line Match

Find Tie Line Match tool analyzes the mismatch in the tie lines and searches correction values.
The tool utilizes the feature-to-feature matching method described in Find match vs. Tie Lines.

In preparation of using this tool, you have to import trajectories into TerraScan and collect tie
lines that are suited for solving the required parameters.

General procedure for solving and apply ing correction parameters:

1. Select the Find Tie Line Match tool.

This opens the Find Tie Line Match dialog:
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2. Define settings and click OK.

SETTING EFFECT

System Scanner system used for collecting the laser
data:

· Airborne - scanner with a line or zig-zag scan
pattern. For scanners with any other scan
pattern, Generic is the better choice, even if
it is an airborne system scanner.

· Generic - mobile system scanner, airborne
system scanner with any other than line or
zig-zag scan pattern.

Source Source file for calculating the correction
values:

· Active tie lines - tie lines in an open Tie line
window are used.

· Tie line file - tie lines stored in a tie line file
are used.

Tie lines Path to the tie line file that is used for
calculating the correction values. This is only
active when Source is set to Tie line file.

Trajectory dir Directory where the TerraScan trajectory files
are stored.

Solve for Type of solution to find:

· Whole data set - a solution for the whole
data set is calculated.
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SETTING EFFECT

· Line groups - a solution for strips of
different groups is calculated. This requires
that groups are defined for the TerraScan
trajectories.

· Individual lines - a solution for each strip is
calculated.

Scanners Defines how data from different scanners is
used:

· Combined solution - a solution for all
scanners is calculated.

· Solution per scanner - a solution for each
individual scanner is calculated.

Correct Defines how line groups or individual lines are
corrected:

· All solution sets - a solution is calculated for
being applied to all strips or groups.

· Selected sets - a solution only for selected
strips or groups is calculated.

This is only active when Solve for is set to Line
groups or Individual lines.

Easting shift Solves for a constant easting correction value.
This is only active if System is set to Airborne.

Northing shift Solves for a constant northing correction
value. This is only active if System is set to
Airborne.

Z shift Solves for a constant elevation correction
value. This is only active if System is set to
Airborne.

Mirror scale Solves for a mirror scale factor. This is only
active if System is set to Airborne.

Heading shift Solves for a constant heading correction value.

Roll shift Solves for a constant roll correction value.

Pitch shift Solves for a constant pitch correction value.

Lever X Solves for a constant lever arm correction in X
(left - right) direction. This is only active if
System is set to Generic.

Lever Y Solves for a constant lever arm correction in Y
(forward - backward) direction. This is only
active if System is set to Generic.

Lever Z Solves for a constant lever arm correction in Z
(up - down) direction. This is only active if
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SETTING EFFECT

System is set to Generic.

3. If Correct is set to Selected sets, the Select sets to correct dialog opens. Select the group(s) or
line(s) for which to calculate correction values and click OK.

The software calculates correction values for the selected parameters. It opens the Find Tie
Line Match Results dialog. The dialog shows information about the correction values and the
number of usable observations for each parameter.

4. Save a corrections file using the Save corrections command from the File pulldown menu in
the Find Tie Line Match Results dialog. You can also save a text file and print the report by
utilizing the corresponding commands from the File pulldown menu in the dialog.

5. Use the Apply Correction tool from the Match tool box to apply the corrections to the laser
data, tie lines, or other files.

Lever arm corrections should actually not be solved by using tie lines. However, the
functionality can be used to remove remaining mismatch in the data due to lever arm
inaccuracies. Mainly, the options to solve lever arms with tie lines has been implemented in
the software in order to calibrate data from several laser heads of one scanner.
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Combine rotation angle
Key-in command only, under development

Combine rotation angles key-in command opens a dialog in which system misalignment angles
and TerraMatch corrections for heading, roll and pitch can be combined. The software computes
new system misalignment angles from the input and shows them in the lower part of the
dialog.

To combine rotation angles:

1. Type combine rotation angles command in the Spaccels window of Spatix or the Key-in line of
Bentley CAD and press <Enter>.

This opens the Combine Rotation Angles dialog:

2. Select settings for Unit and Order, and type the values for Heading, Roll, Pitch into the
corresponding fields.

The new system misalignment angles are shown in the lower part of the dialog.

SETTING EFFECT

Unit Unit of the misalignment angles: Degree or
Radian.

Order Order of misalignment angles for computing
the correct system misalignment. The list
provides all possible combinations of the
three angles heading, roll and pitch. The
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SETTING EFFECT

probably most common order is Heading
pitch roll.

Heading | Roll | Pitch Original system misalignment angles. They
are normally provided by the system
manufacturer as a result of a system
calibration process.

Heading | Roll | Pitch Misalignment angle corrections computed by
TerraMatch. They are normally a result of a
TerraMatch calibration process and refine the
manufacturer's system calibration.



TerraMatch User Guide  © 2024 Terrasolid Ltd

127Tool Reference > Key-in commands/Spaccels >  

Key-in commands/Spaccels

Key-in commands (Bentley CAD) or Spaccels (Spatix accelerates) are a way to speed up the call
of tools and menu commands. The CAD platforms offer command lines where you can type and
execute the commands. In addition, commands can be assigned to keys (function keys in
Bentley CAD). This speeds up some manual tasks significantly as you can call tools by pressing a
key instead of mouse clicks. Especially tools with optional parameters in their call commands
are well suited for speeding up manual work with keys.

SPATIX BENTLEY CAD

Tools in TerraMatch can be started by
entering a spaccel in the Spatix Spaccels
window. The window contains a command
line and two lists that help to find the correct
syntax of a command.

Most of the tools in TerraMatch can be started
by entering a key-in command in the Bentley
CAD Key-in line. The Browse Key-in option of
the Key-in line can be used to find out the
syntax of a key-in command.

The upper list in the Spaccels window lists all
available spaccels. This includes commands
for calling tools of Spatix and any loaded
IxApp, such as Terra applications.
If you know approximately the beginning of
the command syntax, start typing the first
word. The list of spaccels is reduced to those
that start with the typed letters. This helps to
find the correct command syntax.
You can select a spaccel from the list with a
double-click. This writes the spaccel in the
command line on the top of the window.
Press <Enter> in order to execute the
command. This starts the corresponding tool.
The lower list in the Spaccels window lists
spaccels that have been executed. To repeat a
command, you may select it from this list with
a double-click and press <Enter>.

If you select TMATCH in the list at the lower
right corner of the Browse Key-in dialog, the
selection of commands is limited to
TerraMatch commands only. There are four
list fields that show available commands.
Select the first word of a command in the left
list. This adds the word to the command line
and displays matching second words in the
second-left list field. Select the second word
of a command. This adds the word to the
command line and displays any matching
third words in the next list field. Continue
until a command is complete.
If you know approximately, how a command
looks like, you may start typing the command
in the Key-in line. The software automatically
completes words of the command, so you just
type the first letter(s) and then, confirm the
suggested word with <Space>.
Press <Enter> in order to execute a key-in
command. This starts the corresponding tool
or performs another action called by the
command.
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SPATIX BENTLEY CAD

In Spatix, you can assign commands to any key
or combination of keys. Key assignments are
defined in the Shortcuts window. The
window lists all tools/function calls of the
software and lets you define a key
(combination) for selected ones. In addition,
Spaccels for commands with optional
parameters can be defined and assigned to a
key (combination) as well.

In Bentley CAD, you can assign commands to
function keys. This is done in the Function
keys category of User Settings. You first need
to select the function key and then, type the
correct command in the command line. Set
the command with <Enter>.

This Chapter lists a selection of commands and their optional parameters. Some of them you
may consider assigning to keys. For each command, a link to the corresponding tool or menu
command is given. Use this link to jump to a more detailed description of the tool/command.

The syntax of commands/spaccels is the same in all CAD platforms. Also optional parameters
for function calls are defined in the same way.

KEY-IN COMMAND

apply correction

define tie lines

find rubbersheet fit

find tie line fluctuations

find tie line match

KEY-IN COMMAND

match add elevation point

match add ground line

match add ground point

match add known point

match add xy point

match app maintool

Apply Correction

Apply Correction starts the Apply correction tool.

Syntax:

apply correction

Define Tie Lines

Define Tie Lines starts the Define Tie Lines tool.

Syntax:

define tie lines
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Find Rubbersheet Fit

Find Rubbersheet Fit starts the Find Rubbersheet Fit tool.

Syntax:

find rubbersheet fit

Find Tie Line Fluctuations

Find Tie Line Fluctuations starts the Find Tie Line Fluctuations tool.

Syntax:

find tie line fluctuations

Find Tie Line Match

Find Tie Line Match starts the Find Tie Line Match tool.

Syntax:

find tie line match

Match App Maintool

Match App Maintool opens the TerraMatch main tool box. By default, the tool box is opened
when TerraMatch is loaded. The command can be used to re-open the tool box after it was
accidentally closed.

Syntax:

match app maintool

Match Add Elevation Point

Match Add Elevation Point starts the tool for placing elevation point type of tie lines.

Syntax:

match add elevation point

Match Add Ground Line

Match Add Ground Line starts the tool for placing ground line type of tie lines.
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Syntax:

match add ground line

Match Add Ground Point

Match Add Ground Point starts the tool for placing ground point type of tie lines.

Syntax:

match add ground point

Match Add Known Point

Match Add Known Point starts the tool for placing known point type of tie lines.

Syntax:

match add known point

Match Add Xy Point

Match Add Xy Point starts the tool for placing xy point type of tie lines.

Syntax:

match add xy point
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Configuration Variables for Bentley CAD platforms

Bentley CAD applications are able to locate TerraMatch with the help of configuration variables.
When you install TerraMatch, the installation program will create a configuration file
TERRA.CFG which defines the required environment variables. This file is placed in Bentley CAD
tool's CONFIG\APPL sub-directory.

For example, C:\USTATION\CONFIG\APPL\TERRA.CFG may contain:

#--------------------------------------------------

#  TERRA.CFG - Configuration for Terra Applications

#--------------------------------------------------

TERRADIR=c:/terra/

TERRACFG=$(TERRADIR)config/

TERRADOCS=$(TERRADIR)docs/

MS_MDLAPPS < $(TERRADIR)ma/

%if exists ($(TERRACFG)*.cfg)

%   include $(TERRACFG)*.cfg

%endif 

This configuration file will include all the configuration files in C:\TERRA\CONFIG directory.
TerraMatch's configuration file TMATCH.CFG contains:

#--------------------------------------------

#  TMATCH.CFG - TerraMatch Configuration File

#-------------------------------------------- 

# Directory for storing the user license file (TMATCH.LIC)

TMATCH_LICENSE=$(TERRADIR)license/

# Directory for user preferences (TMATCH.UPF) 

TMATCH_PREF=$(TERRADIR)tmatch/

# Directory for application settings (TMATCH.INF)

TMATCH_SET=$(TERRADIR)tmatch/

In a default configuration, Bentley CAD automatically includes these settings as configuration
variables. You can check the values for these variables in the Configuration Variables dialog of
Bentley CAD. In case these variables have not been defined correctly, you should define them
manually.
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Installation Directories

TerraMatch shares the same directory structure with all Terra Applications. It is recommended
that you install all Terra Applications in the same directory.

The list below shows a typical directory structure when TerraMatch has been installed in path C:
\TERRA64.

C:\TERRA64 installation directory for Terrasolid
applications

 app application files for Spatix

 tmatch.ix application

 tmatchsb.dll library

 config application configuration files

 tmatch.cfg defines environment variables for
Bentley CAD

 tmatch.ini defines environment variables for
Spatix

 license user license files

  tmatch.lic user license

 ma application files for Bentley CAD

  tmatch.ma application

  tmatch.dll library

  tmatchsb.dll library

 tmatch user settings and configuration files
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Scripting interface

TerraMatch implements a scripting interface which you can use to send key-in commands to the
CAD system. Any programming method provided by the CAD system is applicable, such as MDL,
Bentley CAD Visual Basic or simply function key definition. In your own code, you may launch
any action available in TerraMatch as toolbox icon, pulldown menu command or dialog push
button, and set values of any dialog variable. Actions and dialog variables are only available
when the corresponding dialog is created. This ensures that the application state is ready for
the action or for setting a variable.

Scripting key-in commands

TerraScan, TerraPhoto, TerraMatch and TerraModeler implement the same scripting interface
and thus, work with the same key-in command logic. The key-in commands below show the
syntax for TerraMatch commands while examples are given from TerraScan. The syntax for the
other applications follow logical rules:

APPLICATIO
N

SET
LOGGING

LAUNCH
ACTION

SET
VARIABLE

TerraScan scan log scan action scan set

TerraPhoto photo log photo
action

photo set

TerraMatch match log match
action

match set

TerraModel
er

model log model
action

model set

Match Log Dialogs logfile

Match Log Dialogs logfile starts to write actions and dialog variables to a text file at a given
location on the hard disc. E.g., "scan log dialogs d:\logs\dialogs.txt" writes the logfile
"dialogs.txt" in directory d:\logs\ on the hard disc. If the file does not exist, it is created when
the first action to log is performed.

The command is most useful to find out action, dialog and variable names. Start the logfile
creation by using the key-in command in the Key-in lineBentley CAD or Spaccels windowSpatix. Call the
tool or command in the software and define settings in the dialog. Close the dialog with OK or
Cancel. The application writes the dialog name, variable names and setting values into the
logfile.

Use the key-in command without the logfile variable in order to stop writing actions to the
logfile.
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Match Action action

Match action action starts the given action. E.g. "scan action trajectviewfields" launches the
command View fields in the Trajectory window which means it opens the View Trajectory
Fields dialog. Actions are linked to dialog push buttons or dialog pulldown menus in the
software. An action can be started only when the dialog is open.

Match Action HideDialog

Match action hidedialog instructs the software to keep the next modal dialog hidden and close
it with OK.

Match Set variable = value

Match set variable = value assigns the given value to the given variable. E.g. "scan set
VtfNumber=1" sets the Number attribute to be visible in the View Trajectory Fields dialog. If
there is no matching variable in an open dialog, the application stores the variable-value-
assignment in a buffer. When the next dialog is created, it will apply the assignment and clear
the buffer.

Match Close Dialog dialog

Match close dialog dialog closes a modeless dialog with the given name. E.g. "scan close dialog
ManageTrajectories" closes the Trajectories window.

Scripting examples (Bentley CAD VBA)

TerraMatch setup provides an example script that includes Bentley CAD VBA modules. The
script is stored in the \EXAMPLE folder of the Terra installation directory, e.g.
C:/TERRA64/EXAMPLE/SCRIPTING_EXAMPLE.MVBA. The example script can be loaded in the
VBA Manager of Bentley CAD and used, for example, as starting point for own scripts.
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